
 File Menu



File Menu

n New SlideShow creates a new slide show of the forms you select and annotates the forms with text from SpecMaker.

n Open SlideShow opens an existing slide show.

n Save Documents saves the information in SpecMaker, all Vision StoryBoard configurations, and the current slide show.

n Save SlideShow saves the current slide show.

n Save SlideShow As saves the current slide show with the name, drive, and directory that you select.

n Generate 

n Document generates an output document.

n Online Help generates online help for your project.

n View Generated Online Help opens the project directory which contains the generated online help file(s) for your project.

n Launch RoboHELP opens the online help .rtf file in RoboHELP. This command is only available when RoboHELP is installed 
on your computer.

n Exit gives directions for closing Vision StoryBoard.



File Menu

New SlideShow

Open SlideShow

Save Documents

Save SlideShow

Save SlideShow As

Generate  Document
Generate  Online Help
View Generated Online Help
Launch RoboHELP
Exit



New SlideShow Command 



New SlideShow Command (File Menu)

Creates a new slide show of the forms you select and annotates the forms with text from SpecMaker.

How?



New SlideShow Dialog Box



New SlideShow Dialog Box

Forms

Shows the names of the forms in the current Visual Basic project.

Selected Forms

Select the forms that you want to include in the slide show.

How?

Configure Size Of Slide

Select a slide size (small, medium, or large). 

Configure Size Of Callout

Select a callout size (small, medium, or large). 

More information.



Open SlideShow Command (File Menu)



Open SlideShow Command (File Menu)

Opens an existing slide show.

How?



Open Existing SlideShow Dialog Box



Open Existing SlideShow Dialog Box

File Name

Select the name of the slide show you want to open.

Directories

Select the directory that contains the slide show you want to open.

List Files of Type

SlideShow Files (*.stb) is the only available option.

Drives

Select the drive that contains the slide show you want to open.

More information.



Save Documents Command (File Menu)



Save Documents Command (File Menu)

Saves the information in SpecMaker, all Vision StoryBoard configurations, and the current slide show. 

How?



Save Documents Button



Save Documents Button

Saves the information in SpecMaker, all Vision StoryBoard configurations, and the current slide show. 

How?



Save Documents Button

Saves the information in SpecMaker, all Vision StoryBoard configurations, and the current slide show. 

How?



Save Documents Button

Saves the information in SpecMaker, all Vision StoryBoard configurations, and the current slide show. 



Vision StoryBoard Files

The information entered in Vision StoryBoard is saved in the same directory as the Visual Basic project. The files StoryBoard 
creates are of the following types:

General StoryBoard Files

n The ProjectName.ST1 file contains Vision StoryBoard configurations, project information, and any information you entered in 
SpecMaker. The ST1 file is updated when you click the save documents button in the StoryBoard main window.

n The ProjectName.ST2 file contains bitmaps of the forms. 

n If Convert to Team Development is selected, a separate file is created for each form and named FormName.ST2. 

How?

SlideShow File

n The FileName.STB file contains the slide show. The default name is ProjectName.STB.

Output Document File

n The ProjectName.RTF file is the rich text format file which is used for the output document generated by StoryBoard which 
can be opened in a word processing program. The rich text format encodes formatted text and graphics for easy transfer 
between different programs and different operations.

Online Help Files

The online help files StoryBoard generates are created with the 16-bit Help Compiler provided with Visual Basic. You can use 
the 32-bit version of the Windows Help Compiler to convert the online help to 32-bit.

n HLP File: The HLP file is the final, compiled help file which displays online help for your project. You select the file name of the
HLP file. The .HLP file name can only be eight characters long. The default file name for this file is the first eight letters of the 
project name. For example, if your project were named “MYPROJECT,” the default .hlp file for online help would be 
“MYPROJEC.HLP.” Please note that the online help .rtf and .hh file names are derived from the name of the .hlp file. If 
RoboHELP is installed on your computer, the .hpj file name is also derived from the .hlp file name. Otherwise, the .hpj file 
name is the same as the .hlp file name.

n HPJ File: The HPJ file is an ASCII text file that is used to compile your Help file. This project file contains all the information 
needed to combine the topic (.rtf) file and other elements into a Help file. The HPJ file naming convention depends on whether
RoboHELP is installed on your computer:

n If RoboHELP is installed on your computer, the HPJ file name can be only eight characters long, and must end in _H. The 
default file name for the online help .hpj file is the first six characters of the .hlp file name, followed by _H. This name 
matches the name of the .rtf and the .hh files. For example, if your project were named “MYPROJECT,” the default .hpj file 
for online help would be “MYPROJ_H.HPJ.” Please remember that this file name is derived from the first 6 letters of 
the .hlp file name.

n Otherwise, the HPJ file name is the same as the HLP file name (see above).

n RTF FILE: The RTF file is the rich text format file which is used for the online help generated by StoryBoard which can be 
opened in a help authoring tool such as RoboHELP. The file name can be only eight characters long, and must end in _H. The
default file name for the online help .rtf file is the first six characters of the .hlp file name, followed by _H. This name matches 
the name of the .hpj and the .hh files. For example, the .hlp file were named “MYPROJEC.HLP,” the default .rtf file for online 
help would be “MYPROJ_H.RTF.” Please remember that this file name is derived from the first 6 letters of the .hlp file name.

n HH File: The HH file provides a list of Help Topics and their associated Help Context IDs for mapping context-sensitive Help. 
The file name can be only eight characters long, and must end in _H. The default file name for the online help .hh file is the 
first six characters of the .hlp file name, followed by _H. This name matches the name of the .hpj and the .rtf files. For 
example, if your .hlp file were named “MYPROJEC.HLP,” the default .hh file for online help would be “MYPROJ_H.HH.” 
Please remember that this file name is derived from the first 6 letters of the .hlp file name.

n HlpHdr.RTF File: The HlpHdr.RTF file contains configuration information about the online help project.

n Error.LOG File: The Error.LOG file is a function of the Windows Help Compiler and contains information about the generated 
online help file.

Note

The online help files generated by StoryBoard are created with the 16-bit Help Compiler provided with Visual Basic. As a 
result, the online help file names must be eight characters or less. You can use the 32-bit version of the Windows Help 
Compiler in Windows 95 to convert the online help to 32-bit.

Warning

If you are generating more than one version of online help for a project, make sure that the first 6 characters of the .hlp file 
name for each generated online help are unique. Because the .rtf and .hh file names (and the .hpj file name if you have 



RoboHELP installed on your computer) are derived from the first 6 characters of the .hlp file name, the files “samples2.hlp” 
will generate the same .hpj, .rtf and .hh file names (sample_H.hpj, sample_H.rtf and sample_H.HH) as “samples1.hlp”, 
overwriting the samples1 .hpj, .rtf and .hh files. 

{button ,AL(`saving documents;saving slide shows;online help',0,`',`')}    Related Topics



 Save SlideShow Command (File Menu)



Save SlideShow Command (File Menu)

Saves the current slide show.

If the slide show has not been saved before, this command displays the Save SlideShow dialog box from which you can save the
slide show.

How?



 Save SlideShow Dialog Box



Save SlideShow Dialog Box

File Name

Enter a new name for the slide show.

Save File as Type

Select STB.

Directories

Select the directory where you want to store the slide show.

Drives

Select the drive where you want to store the slide show.

More information.



 Save SlideShow As Command (File Menu)



Save SlideShow As Command (File Menu)

Saves the current slide show with the name, drive, and directory that you select.

How?



 Save SlideShow As Dialog Box



Save SlideShow As Dialog Box

File Name

Enter a new name for the slide show.

Save File as Type

Select STB.

Directories

Select the directory where you want to store the slide show.

Drives

Select the drive where you want to store the slide show.

More information.



 Generate Document Command (File Menu)



Generate Document Command (File Menu)

Generates an output document.

How?



 Generate Document Dialog Box



Generate Document Dialog Box

File Name

Enter a name and directory for the file or click the browse button to open the Browse dialog box. 

More information.

Forms

Select a Document Type

Select a document type from the list. 

Groups

If the forms are in form groups, select a group. The forms in the group appear in the Forms list. To list forms that are not in a 
group, select the project (the highest level group). 

Forms

Shows the forms in the selected group.

Selected Forms

Select the forms to include in the output document. 

How?

Slides

Slides

Lists the slides in the current slide show.

Selected Slides

Select the slides to include in the output document. 

How?

More information.



 

Generate Document Button



Generate Document Button

Generates an output document.

How?



Generate Document Button

Generates an output document.

How?



Generate Document Button

Generates an output document.



 Generate Online Help Command (File Menu)



Generate Online Help Command (File Menu)

Generates an online help file for your project.

How?



 

Generate Online Help Button



Generate Online Help Button

Generates Online Help for your project.

How?



Generate Online Help Button

Generates Online Help for your project.

How?



Generate Online Help Button

Generates Online Help for your project.



 Generate Online Help Dialog Box



Generate Online Help Dialog Box

Help File drop-down list box:

Enter a name and directory for the file or click the browse button to open the Browse dialog box. 

Exclude Controls without Help Text check box

n Check this box to exclude controls which have no Help Text from online help, regardless of whether the control type has been 
associated with help.

n Uncheck this box to generate Help Topics for every control in the project whose control type has been associated with help.

Note

You can associate control types with online help in the Configure Online Help dialog box.



 Generating Help Dialog Box



Generating Help Dialog Box

The Generating Help dialog box appears after you have clicked the OK button in the Generate Online Help dialog box. Initially, it 
provides a status bar indicating how much of the online help has been compiled. During the compile, any form that is not open in 
the current session will open briefly in the background for bitmap capture.

After compilation, a status message appears to indicate that the online help generation is complete.

Generated Files frame

The Generated Files frame specifies the online help files which have been generated and their location.

View button

Click this button to View the generated online help file.

Launch RoboHELP button

Click this button to open the online help RTF file in RoboHELP. When you save the .rtf in RoboHELP for the first time, you are 
prompted to associate an online help project file. You can associate either the online help project file (.hpj) which StoryBoard has
provided, or associate another .hpj. The map file (.hh)  generated by StoryBoard will automatically be associated with the help 
project at this time.

Note

The Launch RoboHELP button does not display in StoryBoard unless RoboHELP is installed on your computer.



 Browse Dialog Box 



Browse Dialog Box 

File Name

To save the output document file with a new name or in a different location, type a new file name. 

To save the file with an existing file name, select the name in the list or type the current name. When you choose the OK button, 
Vision StoryBoard asks if you want to overwrite the existing file.

Save File As Type

Select RTF Files (*.rtf).

Drives

Select the drive where you want to store the document.

Directories

Select the directory where you want to store the document.



 View Generated Online Help Command (File Menu)

Opens the project directory which contains the generated online help file for your project. Double-click on the help file you want 
to view.



View Generated Online Help Command (File Menu)

Opens the project directory which contains the generated online help file for your project. Double-click on the help file you want 
to view.



Launch RoboHELP (File Menu)

Opens the online help RTF file in RoboHELP.

Note

The Launch RoboHELP command does not display in the StoryBoard Files Menu unless RoboHELP is installed on your 
computer.

Note

When you save the rtf in RoboHELP for the first time, the online help project file (.hpj)  and map file (.hh)  from StoryBoard are 
automatically associated.



Launch RoboHELP (File Menu)

Opens the online help RTF file in RoboHELP. 

Note

The Launch RoboHELP command does not display in the StoryBoard Files Menu unless RoboHELP is installed on your 
computer.

Note

When you save the rtf in RoboHELP for the first time, the online help project file (.hpj)  and map file (.hh)  from StoryBoard are 
automatically associated.



 Exit Command (File Menu)



Exit Command (File Menu)

Gives directions for closing Vision StoryBoard. 

How?



 Tools Menu



Tools Menu

n SpecMaker opens the SpecMaker window in which you can record information about controls and forms in your Visual Basic 
project.

n SlideShow opens an existing slide show or creates a new one. If a slide show is already open, it restores the SlideShow 
window.

n Configure

n Form Groups displays a dialog box in which you can organize your Visual Basic project forms into groups for the output 
document. 

n Control Display displays a dialog box in which you configure SpecMaker and SlideShow.

n Document displays a dialog box in which you configure the output document.

n Online Help displays a dialog box in which you configure the online help file.

n Convert to Team Development creates a separate file for each form, when the Vision StoryBoard project is saved, so that 
forms can be documented in SpecMaker individually. This command cannot be reversed. 



Tools Menu

SpecMaker

SlideShow

Configure

Form Groups

Control Display

Document

Online Help

Convert to Team Development



 SpecMaker Command (Tools Menu)



SpecMaker Command (Tools Menu)

Opens the SpecMaker window in which you can record information about controls and forms in your Visual Basic project. 

How?



 

SpecMaker Button



SpecMaker Button

Opens SpecMaker in which you can record information about controls and forms in your Visual Basic project. 

How?



SpecMaker Button

Opens SpecMaker in which you can record information about controls and forms in your Visual Basic project. 

How?



SpecMaker Button

Opens SpecMaker in which you can record information about controls and forms in your Visual Basic project. 



 SlideShow Command (Tools Menu)



SlideShow Command (Tools Menu)

Opens an existing slide show or creates a new one. If a slide show is already open, it restores the SlideShow window.

How?



 

SlideShow Button



SlideShow Button

Opens an existing slide show or creates a new one. If a slide show is already open, it restores the SlideShow window.

How?



SlideShow Button

Opens an existing slide show or creates a new one. If a slide show is already open, it restores the SlideShow window.

How?



SlideShow Button

Opens an existing slide show or creates a new one. If a slide show is already open, it restores the SlideShow window.



 Open SlideShow Dialog Box



Open SlideShow Dialog Box

This dialog box appears if no slide show is open when you choose  from the Vision StoryBoard toolbar or SlideShow from 
the Tools menu.

n New SlideShow creates a new slide show. 

How?

n Existing SlideShow opens an existing slide show. 

How?



 Configure Form Groups Command (Tools Menu)



Configure Form Groups Command (Tools Menu)

Configures form groups.

How?



 Configure Form Groups Dialog Box



Configure Form Groups Dialog Box

New Button

Creates a new form group. 

How?

Del Button

Deletes the selected form group. The forms return to the project level. 

How?

Edit Button

Edits the name of the form group. 

How?

Up or Down Arrow

Moves a form group up or down in the list. 

How?

Groups

Lists the existing form groups.

Files

Lists the forms in the selected form group.

Group Description

Enter a description of the form group in the text box.



 Groups - New Dialog Box



Groups - New Dialog Box

Group Name

Enter a name for the new form group.

More information.



 Groups - Edit Dialog Box



Groups - Edit Dialog Box

Group Name

Change the name of the form group.

More information.



 Configure Control Display Command (Tools Menu)



Configure Control Display Command (Tools Menu)

Configures two parts of Vision StoryBoard:

SpecMaker 

SlideShow 



 Configure Control Display Dialog Box



Configure Control Display Dialog Box

In the Configure Control Display dialog box, you can complete several tasks:

n Select the document categories to display in the SpecMaker Window for each control type.

n  Add new document categories and edit or delete existing document categories.

n Select the control types to be annotated by default and the document category to use for the annotation text in a new slide 
show. 

n Select the control types to be annotated by default in online help. 

Control Type

n Select All Controls to add or delete a document category, or to change a document category’s status message, number of 
lines, or default association. 

n Select a specific control type to change the Associated option for a document category. The Associated option overrides the 
default association for a particular control type, and determines whether or not the control type is available for generation in an
output document or online help.

n Select a specific control type to change the SlideShow configuration. 

n Add a new control type to the list of controls which can be generated in an output document or online help.

Document Category

Doc Category

Shows the name of the document category.

n Enter a name when you add a new category. 

n Do not change the name of an existing category. The effect is the same as deleting the category. All information is lost 
permanently. 

n Displays a message if the selected document category is assigned to online help.

Status Message

Enter a message to appear at the bottom of the SpecMaker window when the focus in on this category. 

Lines

Enter the number of lines for the text box for this category. This number sets the height of the text box. The box height can be 
used to provide a visual cue for the amount of text to enter in the box. This setting does not limit the amount of data that can be 
entered. Scroll bars appear if more text is entered.

Default Association/Associated

This column is labeled Default Association when All Controls is selected and Associated when a specific control type is selected. 

n Enter or change the default association for a document category when All Controls is selected. If the default is set to Yes, the 
category appears by default in the SpecMaker window for all control types. If the default is set to No, the category does not 
appear.

n Override the default association for a specific control type by changing the Associated option when the control type is 
selected. If Associated is set to Yes, the category appears for the control type. If it is set to No, the category does not appear.

How?

The information entered in a category when it is associated with the control type is not lost when the category is not associated 
with it. The information can be shown in SpecMaker again by changing the default association or the Associated option to Yes.

SlideShow

Annotate in Slide Show by Default

Select this option if you want all of the controls of the selected control type to be annotated by default when you create a new 
slide show. You can override the default for an individual control using the Annotate in Slide Show option in the SpecMaker 
window.

Document Category for Default Annotate Text in Callouts

Select the document category to use as the annotation text for the selected control type when you create a new slide show. Only 
one document category can be used as the annotation text for each control type.



 Configure Documents Command (Tools Menu)



Configure Documents Command (Tools Menu)

Configures the output documents. 

How?



 Configure Documents Dialog Box



Configure Documents Dialog Box

Document Type

Select a document type from the list. The document type determines the header, fonts, and document categories to include in an
output document. 

The header is the name of the document type, for example, Functional Specification. The fonts and document categories 
selected in this dialog box are saved with the document type when you save the Vision StoryBoard project. 

There are five document types:

n Requirements Specification

n Functional Specification

n Implementation Specification

n Test Specification

n End-user Doc Specification

Document Categories Tab

For each control type, specifies the document categories to include in the output document. With Configure Documents, you can 
determine how much of the information entered in Vision StoryBoard appears in the output document.

More information.

Font Tab

Specifies the font name, size, and style for the components of the output document.

More information.



 Document Categories Tab



Document Categories Tab

Document Type

Select a document type from the list next to the Font tab. 

Control Types

Select a control type. 

Document Categories

Name

Lists the document categories for the selected control type.

Print

Select Yes for the categories that you want to include in the output document. The default is the value entered in the Associated 
column in the Configure Control Display dialog box.

How?

Document Category For Summary Table

Select the document category to use in the summary table for each control type.

How?

No Details in Specification

Select this option if you do not want to include any of the document categories for the selected control type. This option is the 
same as selecting No under Print for each document category for a selected control type.



 Font Tab



Font Tab

Document Type

Select a document type from the list next to the Font tab. 

Document Components

Select a document component. 

Font Preview

Shows the selected font.

Font Names

Type or select a font name. Vision StoryBoard lists the fonts available with the current printer driver and additional fonts installed 
in your system.

Font Styles

Select a style. To use the default type style for a given font, select Regular. 

Font Sizes

Type or select a size. The sizes available depend on the printer and the selected font. If the size you type is not available on the 
current printer, Vision StoryBoard chooses the closest available size.

More information.



Configure Online Help Command (Tools Menu)



Configure Online Help Command (Tools Menu)

Configures the online help project file. 

How?



 Configure Online Help Dialog Box



Configure Online Help Dialog Box

Document Category Frame

Select a Document Category to include as the Help Text for the generated Online Help. 

Assign Help for Controls Frame

Specify which control types to include in online help.

More information.



 Convert to Team Development Command (Tools Menu)



Convert to Team Development Command (Tools Menu)

Creates a separate file for each form so that the forms can be documented in SpecMaker individually. 

How?



 Help Menu



Help Menu

n Contents opens Vision StoryBoard Help with the Contents tab showing.

n Search for Help On opens Vision StoryBoard Help with the Index tab showing.

n Obtaining Technical Support gives information on obtaining Technical Help.

n Quick Preview gives directions for running a quick introduction to Vision StoryBoard.

n About Vision StoryBoard gives Vision StoryBoard version and copyright information.



Help Menu

Contents

Search for Help On

Obtaining Technical Support

Quick Preview

About Vision StoryBoard



 Contents Command (Help Menu)



Contents Command (Help Menu)

Displays the contents of the Vision StoryBoard Help system.

As you look through Help, you can return to the Contents by clicking the Help Topics button in the Help window.



 Search for Help On Command (Help Menu)



Search for Help On Command (Help Menu)

Searches Vision StoryBoard Help for information related to topics that you specify. 



 Obtaining Technical Support Command (Help Menu)



Obtaining Technical Support Command (Help Menu)

Gives information on how to obtain technical help on Vision StoryBoard from Vision Software.

How?



 Quick Preview Command (Help Menu)



Quick Preview Command (Help Menu)

Gives directions for playing Quick Preview, an online introduction to Vision StoryBoard. 

How?



 About Vision StoryBoard Command (Help Menu)



About Vision StoryBoard Command (Help Menu)

Gives Vision StoryBoard version and copyright information.



 Obtaining Technical Support



Obtaining Technical Support

Before contacting Vision Software Technical Support, check the Vision StoryBoard user’s guide and online Help. If you still 
cannot solve the problem, you can obtain product support in several ways:

Fax

You can fax questions or comments to the following number:

Vision Software Technical Support Fax: 510-238-4101

Phone

You must be a registered user to call Technical Support. Technical Support is available between 8:30 a.m. and 5:00 p.m. Pacific 
time, Monday through Friday, at the following number:

Vision Software Technical Support Phone: 510-238-4100

Online

You can contact Technical Support online:

Internet: techsupport@vision-soft.com

The Web: www.vision-soft.com

CompuServe: GO VSOFT

Vision Software’s support services are subject to Vision Software’s prices, terms, and conditions in place at the time the service 
is used.



 Quick Preview



Quick Preview

Quick Preview highlights four of the major functional areas of Vision StoryBoard: SpecMaker, SlideShow, Generate Document, 
and Configure. You can start Quick Preview from the Start button or from Windows Explorer. 

To start Quick Preview from the Start Button

1 Click the Windows Start button, and then point to Programs.

2 Point to the folder that contains Vision StoryBoard.

3 Click .

To play Quick Preview from Windows Explorer

1 Open Windows Explorer.

2 Display the directory in which you installed Vision StoryBoard. (The default directory is c:\Program Files\Vision StoryBoard 
4.0.)

3 Double-click demo.exe.

Note

Quick Preview is a product overview demonstration. It is not a tutorial. A tutorial is available in the Vision StoryBoard User's 
Guide.



Demo Icon

Starts Quick Preview.



 Welcome to Vision StoryBoard



Welcome to Vision StoryBoard

If you start Vision StoryBoard when Visual Basic is not running, the Welcome dialog box appears.

Choose one of the following:

Quick Slide Show to create a quick slide show and open Vision StoryBoard.

Quick Document to create a quick output document and open Vision StoryBoard.

New Project to open a new Visual Basic project and Vision StoryBoard.

Existing Project to open an existing Visual Basic project and Vision StoryBoard. 



Quick Slide Show

Quick Slide Show is an option in the Welcome dialog box. Quick Slide Show makes an annotated slide show of the forms in a 
selected Visual Basic project. 

The slides have callouts for each of the text boxes and command buttons on the forms. In the callout text boxes, Quick Slide 
Show inserts the information entered for those controls in SpecMaker in the document category Functional Description. If no 
information has been entered, the placeholder Annotation Text is used instead. 

How?



Quick Slide Show Button

Creates a quick slide show of the selected Visual Basic project.



Quick Document

Quick Document is an option in the Welcome dialog box. Quick Document generates an output document for a selected Visual 
Basic project. 

The output document includes a screen shot and a list of the controls for each selected form. Information entered in SpecMaker 
for the controls is also included in the document.

How?



Quick Document Button

Creates a quick document of the selected Visual Basic project.



New Project

New Project is an option in the Welcome dialog box. New Project opens a new Visual Basic project and Vision StoryBoard.

To open an new Visual Basic project from the Welcome dialog box
Click 

, or select New Project and choose OK.



 New Project Button

Opens a new Visual Basic project and Vision StoryBoard.



Existing Project

Existing Project is an option in the Welcome dialog box. Existing Project opens an existing Visual Basic project and Vision 
StoryBoard.

To open an existing Visual Basic project from the Welcome dialog box

1 Click , or select Existing Project and choose OK. The Open Existing Project dialog box appears.
2 Navigate to the project that you want to open, select it, and choose the OK button. The project opens in Visual Basic.



Existing Project Button

Opens an existing Visual Basic project and Vision StoryBoard.



 Vision StoryBoard Main Window



Vision StoryBoard Main Window

Click on a menu name or tool for more information.



 SpecMaker Window



SpecMaker Window

The SpecMaker window displays key identifying Visual Basic Properties and the document categories for the control, form, or 
menu item that has the focus in your Visual Basic project. 

Control Name Bar

Displays the name of the control, form, or menu item that has the focus in your Visual Basic project. The name appears 
immediately above the Property frame.

Properties

The Visual Basic properties Form Name, Control Type, Hierarchy, and Control Name are displayed. If the control has a caption, it
is also displayed. You can change only the caption in SpecMaker. If you change the caption here, it is also changed in the Visual 
Basic Properties window.

Help Properties

Provides text boxes to enter the Help Context ID and the Help Title for each control, form, or menu item in your Visual Basic 
project and displays the Online Help Document Category for the project. You can assign a Help Context ID or assign a Help Title 
here. The Help Context ID and Help Title are used when you generate online help.

When you first open SpecMaker, a set of default document categories are provided for each Visual Basic control type. One 
category is associated with online help. You can configure SpecMaker to display other document categories, rename the existing
categories, and delete document categories as desired.

The information you enter in the document categories in SpecMaker can be included in a Vision StoryBoard output document, or 
in an online help file. The information can also be copied into the callouts and text boxes in SlideShow or included in a new slide 
show.

Annotate in Slide Show 

Select the Annotate in Slide Show option if you want the control to be annotated when you create a new slide show. This setting 
overrides the Annotate in Slide Show by Default setting in the Configure Control Display dialog box.

Document Categories

Enter up to 32K of information about the control, form, or menu item in each of the Document Category text boxes. You can 
configure the names of these categories, add new categories, and select which categories to generate in an output document. 
You    can associate one document category to be generated as the HelpText for the online help file. Use this information to 
generate an output document or to generate online help.



 SlideShow Sorter Window



SlideShow Sorter Window

The SlideShow Sorter window displays the slides in the current slide show, the SlideShow Sorter toolbox, and command buttons.

SlideShow Sorter Tools

Click on a tool for more information.

SlideShow Sorter Buttons

Click on a button for more information.



 SlideShow Sorter Toolbox



SlideShow Sorter Toolbox

Click on a button for more information.



 

New Slide Tool



New Slide Tool

Adds a new slide to the slide show.

How?



New Slide Tool

Adds a new slide to the slide show.

How?



New Slide Tool

Adds a new slide to the slide show.



 New Slide Dialog Box



New Slide Dialog Box

Name

Enter a name for the slide.

Description

Enter a description for the slide.

How?



 

Delete Slide Tool



Delete Slide Tool

Deletes the selected slide in the SlideShow Sorter window.

How?



Delete Slide Tool

Deletes the selected slide.

How?



Delete Slide Tool

Deletes the selected slide.



 

Duplicate Slide Tool



Duplicate Slide Tool

Makes a copy of the selected slide.

How?



Duplicate Slide Tool

Makes a copy of the selected slide.

How?



Duplicate Slide Tool

Makes a copy of the selected slide.



 Duplicate Slide Dialog Box



Duplicate Slide Dialog Box

Current Slide Name

Displays the name of the selected slide. If you want to duplicate a different slide, select the name from the drop-down list.

New Slide Name

Enter a name for the new slide.

Description

Enter a description for the new slide.

How?



 

Change Slide Properties Tool



Change Slide Properties Tool

Changes the name and description of the selected slide.

How?



Change Slide Properties Tool

Changes the name and description of the selected slide.

How?



Change Slide Properties Tool

Changes the name and description of the selected slide.



 Change Slide Properties Dialog Box



Change Slide Properties Dialog Box

Name

Displays the name of the selected slide. Change the name if you want.

Description

Displays the description of the selected slide. Change the description if you want.

How?



 

SlideShow Player Command Button



SlideShow Player Command Button

Plays the current slide show. This button appears in the SlideShow Sorter and SlideShow Designer windows.

How?



SlideShow Player Command Button

Plays the current slide show. 

How?



SlideShow Player Command Button

Plays the current slide show. 



 

SlideShow Designer Command Button



SlideShow Designer Command Button

Starts SlideShow Designer for the selected slide. This button is enabled in the SlideShow Sorter window.

How?



SlideShow Designer Command Button

Starts SlideShow Designer for the selected slide. This button is enabled in the SlideShow Sorter window.



SlideShow Designer Command Button

This button is disabled in the SlideShow Designer window.



SlideShow Designer Command Button

Starts SlideShow Designer for the selected slide. 

How?



 

SlideShow Sorter Command Button



SlideShow Sorter Command Button

Returns to SlideShow Sorter from SlideShow Designer. This button is enabled in the SlideShow Designer window.

How?



SlideShow Sorter Command Button

Returns to SlideShow Sorter from SlideShow Designer. 

How?



SlideShow Sorter Command Button

This button is disabled in the SlideShow Sorter window.



SlideShow Sorter Command Button

Returns to SlideShow Sorter from SlideShow Designer. 



 Next Command Button



Next Command Button

Opens the next slide in the slide show in SlideShow Designer.



Next Command Button

Opens the next slide in the slide show in SlideShow Designer.



 Previous Command Button



Previous Command Button

Opens the previous slide in the slide show in SlideShow Designer.



Previous Command Button

Opens the previous slide in the slide show in SlideShow Designer.



 SlideShow Designer Window



SlideShow Designer Window

The SlideShow Designer window displays a slide and the SlideShow Designer toolbox and command buttons.

SlideShow Designer Tools

Click on a tool for more information.

SlideShow Designer Buttons

 
Click on a button for more information.



 SlideShow Designer Toolbox



SlideShow Designer Toolbox

Click on a tool for more information.



 

Add Background Tool



Add Background Tool

Adds a background form to slide. 

How?



Add Background Tool

Adds a background form to slide. 

How?



Add Background Tool

Adds a background form to slide. 



 Add Background Dialog Box



Add Background Dialog Box

Name

Select a slide to insert as the background from the list of slides.

How?



 

Add Form Tool



Add Form Tool

Adds a form to a slide. 

How?



Add Form Tool

Adds a form to a slide. 

How?



Add Form Tool

Adds a form to a slide. 



 Add Form Dialog Box



Add Form Dialog Box

Name

Select the name of the form to add to the slide from the drop-down list box.

How?



 

Create Jump Tool



Create Jump Tool

Lets you create a jump to another slide from a hotspot.

How?



Create Jump Tool

Lets you create a jump to another slide from a hotspot.

How?



Create Jump Tool

Lets you create a jump to another slide from a hotspot.



 Create Jump Dialog Box



Create Jump Dialog Box

Name

Select the name of the slide that you want to jump to.

More information.
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Crop Background Tool

Trims away part of the background slide.

How?



Crop Background Tool

Trims away part of the background slide.

How?



Crop Background Tool

Trims away part of the background slide.



 

Delete Tool



Delete Tool

Removes the selected drawing object.

How?



Delete Tool

Removes the selected drawing object.

How?



Delete Tool

Removes the selected drawing object.



 

Cut Text Tool



Cut Text Tool

Removes selected text and puts it on the Clipboard. 

How?



Cut Text Tool

Removes selected text and puts it on the Clipboard. 

How?



Cut Text Tool

Removes selected text and puts it on the Clipboard. 



 

Copy Text Tool



Copy Text Tool

Copies selected text to the Clipboard. 

How?



Copy Text Tool

Copies selected text to the Clipboard. 

How?



Copy Text Tool

Copies selected text to the Clipboard. 



 

Paste Text Tool



Paste Text Tool

Inserts a copy of the contents of the Clipboard at the insertion point, replacing the selection (if any) with the text on the 
Clipboard. 

How?



Paste Text Tool

Inserts a copy of the contents of the Clipboard at the insertion point, replacing the selection (if any) with the text on the 
Clipboard. 

How?



Paste Text Tool

Inserts a copy of the contents of the Clipboard at the insertion point, replacing the selection (if any) with the text on the 
Clipboard. 



 

Add Text Box Tool



Add Text Box Tool

Lets you draw a text box on a slide.

How?



Add Text Box Tool

Lets you draw a text box on a slide.

How?



Add Text Box Tool

Lets you draw a text box on a slide.



 

Add Callout Tool



Add Callout Tool

Lets you draw a callout on a slide.

How?



Add Callout Tool

Lets you draw a callout on a slide.

How?



Add Callout Tool

Lets you draw a callout on a slide.



 

Draw Line Tool



Draw Line Tool

Lets you draw a line on a slide.

How?



Draw Line Tool

Lets you draw a line on a slide.

How?



Draw Line Tool

Lets you draw a line on a slide.



 

Set Line Style Tool



Set Line Style Tool

Specifies the style for the selected line.

How?



 

Set Line Dialog Box



Set Line Dialog Box

Select a line style.

How?



Set Line Style Tool

Specifies the style for the selected line.

How?



Set Line Style Tool

Specifies the style for the selected line.



 

Set Line Color Tool



Set Line Color Tool

Specifies the color for the selected line.

How?



 

Set Line Color Dialog Box



Set Line Color Dialog Box

Select a color for the line.

How?



Set Line Color Tool

Specifies the color for the selected line.

How?



Set Line Color Tool

Specifies the color for the selected line.



 

Set Text Font Tool



Set Text Font Tool

Specifies the format of the text in the selected callout or text box. 

How?



Set Text Font Tool

Specifies the format of the text in the selected callout or text box. 

How?



Set Text Font Tool

Specifies the format of the text in the selected callout or text box. 



 Font Dialog Box



Font Dialog Box

Font

Type or select a font. The fonts available with the current printer driver and additional fonts installed in your system are listed.

Font Style

Select a font style. To use the default type style for a given font, select Regular. 

Size

Type or select a font size. The sizes available depend on the printer and the selected font. If the size you type is not available on 
the current printer, the closest available size is used.

Effects

Select the formatting options you want. You can select a combination of effects.

Strikethrough

Draws a line through the text.

Underline

Draws a line under the text.

Color

Type or select one of the predefined colors. To display color, you must have a color monitor; to print color, you must have a color 
plotter or a color printer.

Sample

Shows the selected font.

More information.



 

Undo Tool



Undo Tool

Reverses the last text edit.

How?



Undo Tool

Reverses the last text edit.

How?



Undo Tool

Reverses the last text edit.



 

Select Drawing Objects Tool



Select Drawing Objects Tool

Changes the pointer to an arrow so you can select drawing objects. 

How?



Select Drawing Objects Tool

Changes the pointer to an arrow so you can select drawing objects. 

How?



Select Drawing Objects Tool

Changes the pointer to an arrow so you can select drawing objects. 



 SlideShow Player Window



SlideShow Player Window

The current slide show appears one slide at a time in the SlideShow Player window. 

Play the slide show using the buttons and hotspots:

n Click the Previous button to display the previously shown slide.

n Click the Next button to display the next slide in the slide show.

n If a slide contains a hotspot, click the hotspot to display the connected slide. The cursor changes to a pointing hand when it 
moves over a hotspot.

n Click a menu name to display the menu items. 

n If the slide contains a jump from a menu item, click the menu item to display the connected slide. The menu items that are 
jumps appear in green.

n Click the Exit button to close the SlideShow Player window.



Tools Quick Reference

SlideShow Sorter Window

New Slide Tool

Duplicate Slide Tool

Delete Slide Tool

Change Slide Properties Tool

SlideShow Sorter Command Button

SlideShow Designer Command Button

SlideShow Player Command Button

SlideShow Designer Window

Add Background Tool

Add Form Tool

Create Jump Tool

Crop Background Tool

Delete Tool

Cut Text Tool

Copy Text Tool

Paste Text Tool

Add Text Box Tool

Add Callout Tool

Draw Line Tool

Set Line Style Tool

Set Line Color Tool

Set Text Font Tool

Undo Tool

Select Drawing Objects



SlideShow Sorter Command Button

SlideShow Designer Command Button

SlideShow Player Command Button
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All Controls

The Control Type that must be selected in the Configure Control Display dialog box when you add, change, or delete a document
category. The name, status message, number of lines, and default association for a document category are set for all control 
types at the same time.



Annotate in Slide Show Option

The SpecMaker option that determines if a specific control is annotated in a new slide show. This option overrides the default.



Annotate in Slide Show by Default Option

The Configure option that determines if all controls of a particular type are annotated in a new slide show. This default can be 
overridden with the Annotate in Slide Show option in SpecMaker.



Associated Option

The Configure option that determines if a document category appears in the SpecMaker window for a specific control type. This 
option overrides the default association.



Association

The relationship between a document category and a control type that determines if the category appears in the SpecMaker 
window. If a document category is associated with a control type, it appears in SpecMaker.



Browse Button

A button at the end of a File Name text box that opens the Browse dialog box.



Callout

In SlideShow, a text box with a line that points to an area of interest such as a control or frame.



Clipboard

In Windows, a temporary storage location used to transfer text, graphics, and code.



Context-sensitive Help

Context-sensitive help is Help that is accessed by a user’s mouse click while in a running application. Context-sensitive help 
usually appears in a popup window and provides concise information about a selected feature of the application. 



Control

In Visual Basic, an object that you place on a form to enable or enhance user interaction with an application.



Default Association

The Configure option for SpecMaker that determines if a document category appears in the SpecMaker window by default for a 
control type. The default association for a document category is set for all control types at the same time. The default can be 
overridden with the Associated option.



Default Association

Select Yes, if you want this category to appear in the SpecMaker window by default for all control types. Select No if you do not 
want it to appear by default. 



Default Document Categories

The SpecMaker document categories displayed by default for all control types:

n Requirements

n Functional Description

n Design Information

n Testing Information

n End-user Documentation Notes (assigned as Help Text by default)



Designer

The SlideShow view in which you create slides of your forms with callouts and jumps.



Document Categories

In SpecMaker, the text boxes in which you enter information about your application. All document categories can be included in a
Vision StoryBoard output document. One document category at a time can be assigned as the Help Text when generating online 
help for a project.



Doc Category

In the Document Categories frame of the Configure Control Display dialog box, the name of the document category. Do not 
change the name of an existing category. The effect is the same as deleting the category. All information is lost permanently. 



Doc Category

Enter a name for the document category. 

Do not change the name of an existing category. The effect is the same as deleting the category. All information is lost 
permanently. 



Document Type

The type of output document generated by Vision StoryBoard. Document type determines the header, fonts, and document 
categories to include in the output document. There are five types:

n Requirements Specification

n Functional Specification

n Implementation Specification

n Test Specification

n End-user Doc Specification 



Document Components

The parts of the output file generated by Vision StoryBoard. You can set the fonts for each component. Document components 
include these parts of the output document:

Component Name Document Part
HeadingText Text of the Descriptions
Heading Headings 1 though 6
TblHeading Summary Table Headings
TblText Summary Table Body Text
ControlDetailText Control Detail Body Text
ControlHdg Control Detail Heading

Focus

In Windows, the window, form, or control that can receive mouse clicks or keyboard input. Only one object at a time can have the
focus.



Form

In Visual Basic, a window or dialog box that makes up part of an application’s interface. A form is a container for controls.



Form Group

In Vision StoryBoard, a set of forms that are organized together and given a name. The Vision StoryBoard output document is 
organized by these groups.



Generate Document

The Generate Document command generates an output file (.rtf) of the information entered in SpecMaker and SlideShow.



Generate Online Help

The Generate Online Help command generates an online help file (.hlp) based on help information entered in SpecMaker.



Handles

In SlideShow Designer, the black squares that appear in the border of a box or at the ends of a line when it is selected. The 
handles are used to move and size the drawing object.



Header

A line of text that appears at the top of every page in the output document. The header is the name of the document type that is 
selected when the document is generated, for example, Functional Specification.



Help Text

All text you enter into the associated Online Help Document Category in SpecMaker for each form and control in your project. 
This text can be automatically generated into online help by StoryBoard.



Help Context ID

The help identification number assigned for a form or control which is used for mapping context-sensitive help. You can assign 
this value in the SpecMaker Window or in the Visual Basic Properties Window.



Help Title

The unique header text assigned for the help topic of a form, control or menu item in your project. This title appears above the 
Help Text in the generated Online Help. 

The default Help Title assigned for the control is the character string from the Caption property for the object. If no Caption has 
been assigned, the Name Property of the object will be used.



Help Topic

The specific help information for each form or control in your project. A help topic is composed of a Help Context ID, a Help Title 
and Help Text. You can display this information in the generated Online Help for your project.



HH File

A Help file also known as the map file which is used for implementing context-sensitive help for the online help project. This file 
maps the Help Context ID for each form, control, and menu item to associated Help Topics in the online help project. 



HLP File

The final, compiled help file that displays the Help Topics and Help Text for your project in a Windows Help System Format.



HPJ File

The ASCII text file that is used to compile your Help file. This project file contains all the information needed to combine the topic 
file (.rtf) and other elements into a Help file (.hlp).



Hotspot

In SlideShow, the area on a slide that marks the connection to another slide. In SlideShow Designer, the hotspot appears as a 
dotted line box. In SlideShow Player, the cursor becomes a pointing hand as it moves over the hotspot. If you click on the 
hotspot, the slide to which the hotspot is connected appears.



Jump

In SlideShow, a connection from a hotspot or menu item on one slide to another slide. In SlideShow Player, if you click on the 
jump, the slide to which it is connected appears. 



Lines

In Configure, the number of lines for the text box for the document category. This number sets the height of the text box. The box
height can be used to provide a visual cue for the amount of text to enter in the box. This setting does not limit the amount of 
data that can be entered. Scroll bars appear if more text is entered.



Lines

Enter the number of lines for the text box for the document category. This number sets the height of the text box. The box height 
can be used to provide a visual cue for the amount of text to enter in the box. The setting does not limit the amount of data that 
can be entered. Scroll bars appear if more text is entered.



Map File

A Help file with the extension .hh used for implementing context-sensitive help which maps the Help Context ID for each form, 
control, and menu item to associated Help Topics in the online help project. 



Object

In Visual Basic, a form or control.



Online Help Project File

The ASCII text file (.hpj) that is used to compile your Help file. This project file contains all the information needed to combine the
topic file (.rtf) and other elements into a Help file (.hlp).



Online Help File

The final, compiled help file (.hlp) that displays the Help Topics and Help Text for your project in a Windows Help System Format.



Output Document

A file in rich text format (RTF) that contains information from SpecMaker and slides from SlideShow. The RTF file saves 
formatting and can be converted to a document by many word processing programs.



Player

The SlideShow view in which you display the slides in order as a slide show of your application.



Project

In Visual Basic, a collection of forms, modules, and custom control files that make up an application.



Property

In Visual Basic, a named attribute of an control. Properties define control characteristics and control behaviors.



RTF File

Rich text format. An RTF file saves formatting and can be converted to a document or online help.



Rich Text Format

RTF; a type of file format that saves formatting and can be converted to a document or online help.



Slide

In Vision StoryBoard, a slide is a screen shot of one or more forms with callouts, text boxes, and jumps. Slides are created and 
shown in SlideShow.



Slide Size

The slide size (small, medium, or large) determines the area used for the form and the callouts in a new slide show. 

More information.



Slide Size

The slide size (small, medium, or large) determines the area used for the form and the callouts in a new slide show. 

More information.



Callout Size

The callout size (small, medium, or large) determines how much annotation text appears in the callout.

More information.



Callout Size

The callout size (small, medium, or large) determines how much annotation text appears in the callout.

More information.



SlideShow

The Vision StoryBoard window in which you create slides of your forms with callouts and jumps. You can display the slides in 
order as a slide show of your application.



SlideShow Designer

The SlideShow view in which you create slides of your forms with callouts and jumps.



SlideShow Player

The SlideShow view in which you display the slides in order as a slide show of your application.



SlideShow Sorter

The SlideShow view in which you add new slides and organize the slides for a slide show.



Sorter

The SlideShow view in which you add new slides and organize the slides for a slide show.



SpecMaker

The Vision StoryBoard window in which you can record information about the forms and controls in your Visual Basic application.



Status Message

A message that appears at the bottom of the SpecMaker window when the focus is on this category. This message should tell 
the user what type of information to enter in the document category.



Status Message

Enter a message to appear at the bottom of the SpecMaker window when the focus is on this category. This message should tell
the user what type of information to enter in the document category.



Summary Table

In the output document generated by Vision StoryBoard, a table of the controls in a form.



Text Box

A box in which you can display or enter text.



Toolbar

A bar with buttons that perform Vision StoryBoard’s most common tasks.



Toolbox

A box with buttons that perform many common tasks.
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Overview of SpecMaker

In SpecMaker you can document your Visual Basic project by entering information about the individual controls, forms, and 
menu items. 

SpecMaker displays document category text boxes for the control, form, or menu item that has the focus in your Visual Basic 
project. When you move the focus to a different object, SpecMaker displays the document categories for that object.

The Properties frame in SpecMaker lists the form name, control type, hierarchy in the form group, control name, and caption for 
the object which currently has the focus in your Visual Basic project. This information is used when you generate a document for 
your project.

The Help Properties frame in SpecMaker lists the Help Context ID, Help Title, and Online Help Document Category for the object
which currently has the focus in your Visual Basic project. This information is used when you generate online help for your 
project.

When you first open SpecMaker, a set of default document categories are provided for each Visual Basic control type. One 
category is associated with online help. You can configure SpecMaker to display other document categories, rename the existing
categories, and delete document categories as desired.

The information you enter in the document categories in SpecMaker can be included in a Vision StoryBoard output document, or 
in an online help file. The information can also be copied into the callouts and text boxes in SlideShow or included in a new slide 
show.

What do you want to do?
Open SpecMaker
Document a Visual Basic Project
Create Online Help Text
Save a Document
Generate an Output Document
Generate an Online Help File
Configure SpecMaker



Open SpecMaker

Do one of the following:

n Click  on the Vision StoryBoard toolbar.
n From the Tools menu, choose SpecMaker.



Overview of Documenting a Visual Basic Project

You can document your Visual Basic project by entering information about the forms, controls, and menu items in SpecMaker.

The SpecMaker window appears when you start Vision StoryBoard. SpecMaker displays document categories for the control, 
form, or menu item that has the focus in your Visual Basic project. When you move the focus to a different object, SpecMaker 
displays the document categories for that object.

These document categories provide text boxes in which you enter topical information about your project. The caption and status 
message for each category indicate the type of data to enter in that category. You can scroll through the different document 
categories for the object and enter information directly into them. You can also change the name or the subject of a category as 
desired.

The End-user Documentation Notes document category is associated with online help by default. You can enter Help Text for 
your project in this text box.

You can change the captions for controls and forms in SpecMaker in the Properties frame of this window. If you change the 
caption here, it is also changed in the Caption property for the object in your Visual Basic project.

What do you want to do?
Document a Visual Basic Form
Document a Visual Basic Control
Document Menu Items
Create Online Help Text
Assign a Help Context ID
Assign a Help Title
Change a Visual Basic Caption



Document a Visual Basic Form

1 If the SpecMaker window is not open, open SpecMaker. 

How?

2 In your Visual Basic project, select the form that you want to document.

3 Enter information about the form in the document categories. 

4 Use the mouse or TAB key to move to the next document category. Use the scroll bars to scroll to the other document 
categories. 

{button ,AL(`documenting',0,`',`')}    Related Topics



Document a Visual Basic Control

1 If the SpecMaker window is not open, open SpecMaker. 

How?

2 In your Visual Basic project, select the control that you want to document.

3 Enter information about the control in the document categories. 

4 Use the mouse or TAB key to move to the next document category. Use the scroll bars to scroll to the other document 
categories. 

Note

You can document a control as a single object in SpecMaker, but you cannot document the internal details of the control 
separately. 

{button ,AL(`documenting',0,`',`')}    Related Topics



Document Menu Items

1 If the SpecMaker window is not open, open SpecMaker. 

How?

2 Open the Visual Basic Menu Editor and select the menu item.

3 Enter information about the menu item in the SpecMaker document categories. 

4 Use the mouse or TAB key to move to the next document category. Use the scroll bars to scroll to the other document 
categories. 

Note

To view or edit the document categories for a menu item, you must first select the menu item in the Visual Basic Menu Editor.

{button ,AL(`documenting',0,`',`')}    Related Topics



Change a Visual Basic Caption

You can change the caption for a control or form in SpecMaker. If you change the caption here, it is also changed in the Visual 
Basic Properties window.

1 If the SpecMaker window is not open, open SpecMaker. 

How?

2 In your Visual Basic project, select the control or form.

3 In SpecMaker, type the change in the Caption text box in the Properties frame.

4 Press the ENTER key. The caption is also changed in the Visual Basic Properties window.

{button ,AL(`documenting',0,`',`')}    Related Topics



Save Documents

The information in SpecMaker, all Vision StoryBoard configurations, and the current slide show are saved with the Save 
Documents command. 

Do one of the following:

n Click  on the Vision StoryBoard toolbar.
n From the File menu, choose Save Documents.

If the slide show has never been saved, the Save SlideShow dialog box appears. Enter a file name and select a drive and 
directory. Then choose OK.

The information entered in Vision StoryBoard is saved in the same directory as the Visual Basic project in the Vision StoryBoard 
files. 

More information.

{button ,AL(`saving documents',0,`',`')}    Related Topics



Convert to Team Development

Vision StoryBoard can be set so that forms can be documented in SpecMaker by several programmers at the same time. 

When the Vision StoryBoard project is saved with the Convert to Team Development command, a separate file is created for 
each form. The forms can then be documented in SpecMaker individually. If this command is not used, only one programmer can
document forms in SpecMaker at a time.

Warning!

This command cannot be reversed.

To convert to team development

1 In your Visual Basic project, open all the forms that you want to convert to team development.

2 Save your Visual Basic project.

3 From the Vision StoryBoard Tools menu, choose Convert to Team Development.

4 Save the Vision StoryBoard project.

{button ,AL(`saving documents',0,`',`')}    Related Topics



Overview of Configuring SpecMaker

SpecMaker displays a set of document categories in the SpecMaker window. This default set of categories is the same for all 
controls in your Visual Basic project. 

For each project, you can change the SpecMaker configuration in several ways.

What do you want to do?
Change the association between a document category and a control type    
Add a document category 
Delete a document category 
Change a document category’s name 
Change a document category’s status message 
Change a document category’s text box size 
Add or delete control types 



Overview of Changing the Association between Control Types and Document Categories

The association between a document category and a control type determines if the category appears in the SpecMaker window. 
If a document category is associated with a control type, it appears in SpecMaker for that control type. If a category is not 
associated with a control type, it does not appear.

If a document category is disassociated from a control type, any information entered in SpecMaker for that category is saved, 
even though the category no longer appears in SpecMaker. If the category is later associated with the control type again, the 
category and the information reappear in SpecMaker.
{button ,JI(`Vistory.HLP>overview',`Example_The_Association_between_a_Document_Category_and_a_Control_Type')}    
Example

What do you want to do?
Change the Associated option.
Change the default association.

Note

If you want a document category to appear for only a few control types, set the default association to No. Then select each 
control type that you do want the category to appear for and set the Associated option for the document category to Yes.
{button ,JI(`Vistory.HLP>overview',`Example_Setting_the_Default_Association_to_No')}    Example



Example: Setting the Default Association to No

You could define a category called Estimated Completion Date with the default association set to No. To make the category 
appear in SpecMaker for a particular control type, such as Form, select the control type Form and set the Associated value for 
the document category Estimated Completion Date to Yes. Estimated Completion Date will appear in SpecMaker only for forms.



Example: The Association between a Document Category and a Control Type

The category End-user Documentation Notes has the default association set to Yes, so the category appears in SpecMaker for 
all control types. If you do not want to enter End-user Documentation Notes for a particular control type, such as Label, you can 
select the control type Label and set the Associated option for the document category End-user Documentation Notes to No. 
End-user Documentation Notes will not appear in SpecMaker for labels.



Change the Associated Option

You can change the association between a document category and a specific control type by changing the Associated option.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select an individual control type.

4 In the SpecMaker frame, select a document category.

5 Under Associated, select Yes if you want to associate the category with the control type. Select No if you want to disassociate 
this category from the control type.

To change the width of a column in the grid, drag the line between two columns when the cursor changes to a double arrow.

6 When you are finished with the Configure dialog box, choose the OK button.

Note

The Associated option overrides the default association.

{button ,AL(`association',0,`',`')}    Related Topics



Change the Default Association

You can change the association between a document category and all control types by changing the default association.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select All Controls. All Controls must be selected when you change the default association.

4 In the SpecMaker frame, select a document category.

5 Under Default Association, select Yes if you want to associate the category with all control types. Select No if you want to 
disassociate this category from all control types.

6 When you are finished with the Configure dialog box, choose the OK button.

Note

You can override the default association for a specific control type with the Associated option.

{button ,AL(`association',0,`',`')}    Related Topics



Add Document Categories

You can add document categories to the default set of categories for SpecMaker. 

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select All Controls. All Controls must be selected as the control type when you add a document 
category.

4 In the SpecMaker frame, choose the New button. A new line becomes available in the list box.

5 Enter the following information:

{button ,PI(`Vistory.HLP',`Doc_Category_pop_how_to')}    Doc Category

{button ,PI(`Vistory.HLP',`Status_Message_pop_how_to')}    Status Message 

{button ,PI(`Vistory.HLP',`Lines_pop_how_to')}    Lines

{button ,PI(`Vistory.HLP',`Default_Association_how_to')}    Default Association 

6 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`document categories;association',0,`',`')}    Related Topics



Delete Document Categories

Warning!

When you delete a document category from SpecMaker, it is deleted from all of the control types. Any information that has been 
entered in that category for any control is also deleted permanently. 

To delete a document category

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select All Controls.

4 Select the document category.

5 In the SpecMaker frame, choose the Delete button to delete the document category for all control types.

6 When you are finished with the Configure dialog box, choose the OK button.

Note

You cannot delete the document category currently associated with Online Help. If you want to delete the category, you must 
associate Online Help with a different document category first.

How? 

Note

If you want a document category to appear in SpecMaker for some control types and not others, do not delete it. Change the 
Associated option.

How?

{button ,AL(`document categories;association',0,`',`')}    Related Topics



Change a Document Category’s Name

If you change the name of a document category, the effect is the same as deleting the category. You are actually deleting the old
category and any information that may be entered in it and creating a new category.

Warning! 

When you change the name of a category, any information entered in SpecMaker for that category is lost permanently.

{button ,AL(`document categories',0,`',`')}    Related Topics



Change a Document Category’s Status Message

You can change the status message for a document category for all control types as necessary.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select All Controls. All Controls must be selected when you change a document category’s status 
message.

4 In the SpecMaker frame, select a document category.

5 Under Status Message, enter a message to appear at the bottom of the SpecMaker window when the focus is on this 
category. 

6 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`document categories',0,`',`')}    Related Topics



Change a Document Category’s Text Box Size

You can change the text box size for a document category for all control types as necessary.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select All Controls. All Controls must be selected when you change a document category’s text 
box size.

4 In the SpecMaker frame, select a document category.

5 Under Lines, enter the number of lines for the text box for this category. 

6 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`document categories',0,`',`')}    Related Topics



Control Types in Configure Control Display

When you add a control to your Visual Basic project, the document categories for that control type appear in SpecMaker by 
default. However, not all control types are listed in the Configure Control Display dialog box by default.

A control type must be listed in the Configure Control Display dialog box if you want to complete either of these tasks:

n Change the Association between the control type and a document category in SpecMaker. For unlisted control types, the 
document categories specified for All Controls appear in SpecMaker. 

n Exclude or include document categories in the output document. For unlisted control types, the document categories specified
for All Controls are included in the output document.

{button ,JI(`Vistory.HLP>overview',`Example_Control_Types_in_Configure_Control_Display')}    Example

What do you want to do?
Add a control type
Delete a control type



Example: Control Types in Configure Control Display

The control type Image is not listed by default in the Configure Control Display dialog box. If you include an image control on a 
Visual Basic form, SpecMaker displays the document categories that are set up for All Controls. When you generate an output 
document, the document categories for All Controls are included for the image control, even if no information is entered in 
SpecMaker. 

If you add the control type Image to the list of control types in the Configure Control Display dialog box, you can then set the 
Associated option to No for any document categories that you do not want to appear in SpecMaker for image controls. 

You can also select No in the Configure Documents dialog box for any document categories that you do not want to include in 
the output document for image controls.



Add Control Types

You may need to add control types, if you want to control which document categories appear in SpecMaker, in the output 
document, and in online help.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type frame, choose the New button.

4 Enter the name of the control type in the list box.

5 When you are finished with the Configure dialog box, choose the OK button.

The new control type uses the document categories specified for All Controls for both SpecMaker and the output document.

{button ,AL(`control types;help controls',0,`',`')}    Related Topics



Delete Control Types

For ease of management, you can delete control types. Deleted control types revert to the document categories specified for All 
Controls for both SpecMaker and the output document.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select the control type. 

4 In the Control Type frame, choose the Delete button.

5 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`control types',0,`',`')}    Related Topics



Overview of Form Groups

In Vision StoryBoard, you can combine Visual Basic forms in a form group and enter a description for the group in the Configure 
Form Groups dialog box. 

The output document and the online help file generated by Vision StoryBoard are organized by the form groups. The 
documentation for the first group and its forms are generated first, followed by the second group and its forms, and so on. Forms 
that are not in a group are documented after the groups. 

The descriptions of the form groups appear in the output document and in the online help. The description for the highest level 
group is the project description. Other descriptions appear with the appropriate group.

You can add forms to a form group. You can delete any form group but the highest level group. When a group is deleted, its 
forms return to the highest level group. They are not deleted from your Visual Basic or Vision StoryBoard project.

What do you want to do?
Create a new form group
Describe a form group
Describe a project
Change the name of a form group
Add forms to a form group 
Change the order of form groups 
Delete a form group



Create a New Form Group

1 From the Tools menu, choose Configure.

2 Choose Form Groups. 

3 Click the New button. 

4 Type a name for the group in the Group Name text box.

5 Choose the OK button. The Configure Form Groups dialog box appears with the new group.

6 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`form groups',0,`',`')}    Related Topics



Describe a Form Group 

The descriptions of the form groups appear in the output document and in the online help file. The highest level group contains 
the project description. Other descriptions appear with the appropriate group.

1 From the Tools menu, choose Configure.

2 Choose Form Groups. 

3 Select the group in the Groups list box.

4 Type a description in the Group Description text box.

5 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`form groups;creating help',0,`',`')}    Related Topics



Describe a Project 

The descriptions of the form groups appear in the output documents. The description for the highest level group is the project 
description.

1 From the Tools menu, choose Configure.

2 Choose Form Groups. 

3 Select the highest level group in the Groups list box.

4 Type a description in the Group Description text box.

5 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`form groups',0,`',`')}    Related Topics



Change the Name of a Form Group 

1 From the Tools menu, choose Configure.

2 Choose Form Groups. 

3 Select the form group in the Groups list box.

4 Click the Edit button. 

5 Edit the name in the Group Name text box.

6 Choose the OK button.

7 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`form groups',0,`',`')}    Related Topics



Add Forms to a Form Group 

1 From the Tools menu, choose Configure.

2 Choose Form Groups. 

3 Display the group that you want to add forms to in the Groups list box. To display a group’s subgroups, double-click the group.

4 Select the group that contains the form you want to move.

5 Select the form in the Files list box.

6 Drag the form to its new group in the Groups list box.

7 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`form groups',0,`',`')}    Related Topics



Change the Order of Form Groups 

The order of the form groups affects the organization of the output document generated by Vision StoryBoard. The first group 
and all the forms in that group are documented first, followed by the second group and its forms, and so on. Forms that are not in
a group are documented after the groups. 

1 From the Tools menu, choose Configure.

2 Choose Form Groups. 

3 Select the group that you want to move in the Groups list box.

4 Click the up or down arrow above the Groups list box to move the group up or down in the list.

5 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`form groups',0,`',`')}    Related Topics



Delete a Form Group

You can delete any form group but the project (the highest level group). When a group is deleted, its forms return to the highest 
level group. They are not deleted from your Visual Basic or Vision StoryBoard project.

1 From the Tools menu, choose Configure.

2 Choose Form Groups. 

3 Select the group in the Groups list box.

4 Click the Del button.

5 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`form groups',0,`',`')}    Related Topics



Overview of Configuring Documents

You can configure several parts of an output document.

n The document categories to include in the output document. You do not need to include all of the categories that are in 
SpecMaker. You can control the size and content of the output document by the categories you select. The selection of 
document categories is saved with the document type. 

n The summary table document category for each control type. The default is the document category that corresponds to the 
document type. For example, Requirements is the document category used in the summary table in the Requirements 
Specification document type. The summary table document category is saved with the document type. 

n The font for each document component. The fonts selection is saved with the document type.

What do you want to do?
Select the document categories to include in the output document
Select the document categories for the summary tables 
Select the fonts 



Select the Summary Table Document Category

Before you generate an output document, you can select the document category to use in the output document’s summary table 
for each control type.

1 From the Tools menu, choose Configure.

2 Choose Documents. 

3 Select a document type in the list box next to the Font tab. The document category for the summary table is saved with the 
document type.

4 In the Document Categories tab, select a control type.

5 In the Document Category for Summary Table list box, select a document category to use in the output document summary 
table.

6 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`configuring documents;generating documents',0,`',`')}    Related Topics



Select Document Categories

Before you generate an output document, you can select the document categories to include for each control type.

1 From the Tools menu, choose Configure.

2 Choose Documents. 

3 Select a document type in the list box next to the Font tab. The selection of document categories is saved with the document 
type.

4 In the Document Categories tab, select a control type.

5 Under Print, select Yes for each document category that you want to include in the document. The default is the value entered 
under Associated in the Configure Control Display dialog box. 

6 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`configuring documents;generating documents',0,`',`')}    Related Topics



Select Fonts

Before you generate an output document, you can select the fonts to use in the document.

1 From the Tools menu, choose Configure.

2 Choose Documents. 

3 Select a document type in the list box next to the Font tab. The fonts selection is saved with the document type.

4 Choose the Fonts tab.

5 Select a document component in the list box.

6 Select a font name, a font style, and a font size.

7 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`configuring documents;generating documents',0,`',`')}    Related Topics



Overview of Generate Document

You can generate an output document of the information in SpecMaker and SlideShow.

The information from SpecMaker is organized as a document with a descriptive header and the summary table, control 
information, and image of each form. The slides from SlideShow are printed to the file as bitmaps. They are also organized in 
document format. The output document is saved in rich text format. 

Before you generate an output document, you can change the header, fonts, and document categories when you configure the 
document. When you generate the output file, you can select the forms and slides to include.

After you have generated the output document, you can open it in a word processor such as Microsoft Word and print it.

What do you want to do?
Configure an output document
Generate an output document
Print an output document



Generate A Document

You can generate an output document of the information in SpecMaker and the slides in SlideShow. 

1 Do one of the following:

n Click  on the Vision StoryBoard toolbar.
n From the File menu, choose Generate  Document.

The Generate Document dialog box appears.

2 To save the output document with a different name or in a different directory, enter the file name and path in the File Name text
box or click the browse button to open the Browse dialog box.

3 Select a document type from the drop-down list. 

4 If the forms are in form groups, select a group. The forms in the group appear in the Forms list. To list forms that are not in a 
group, select the project (the highest level group). 

5 Select the forms that you want to include in the output document. 

How?

6 Select the slides from the current slide show that you want to include in the output document. 

How?

7 Choose the OK button to generate the output file.

{button ,AL(`configuring documents;generating documents;printing documents',0,`',`')}    Related Topics



Print an Output Document

You can print an output document after opening it in a word processor such as Microsoft Word.

1 Start your word processor.

2 Open the output file in the word processor. Direct the word processor to convert the file from RTF, if it does not do so 
automatically.

3 Print the file from your word processor.

{button ,AL(`generating documents',0,`',`')}    Related Topics
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Overview of Vision StoryBoard

Vision StoryBoard is a tool for planning, documenting, and presenting Microsoft Visual Basic applications.

Vision StoryBoard includes the following major features:

SpecMaker lets you record and present information about forms and controls in your Visual Basic project.

SlideShow lets you create annotated illustrations of the forms and demonstrate the application form flow.

Generate Document lets you create documentation of your project using the information in SpecMaker and SlideShow.

Generate Online Help lets you create a simple online help system for your project using information in SpecMaker.

What do you want to do?
See an online introduction to Vision StoryBoard’s features
Document a Visual Basic project
Create a new slide show



Start Vision StoryBoard from Visual Basic

1 From the Add-Ins menu on the Visual Basic 4.0 tool bar, select Add-In Manager.

2 In the Add-In Manager dialog box, select Vision StoryBoard, and click OK. The Vision StoryBoard main window appears.

Note

Vision StoryBoard is now automatically started with Visual Basic 4.0 until you remove Vision StoryBoard from the Add-In menu.

{button ,AL(`start',0,`',`')}    Related Topics



Start Vision StoryBoard from the Start Button

Warning!

Do not start a second session of Vision StoryBoard if one is already running. Running more than one session of Vision 
StoryBoard at a time may cause problems.

To start Vision StoryBoard from the Start Button

1 Click the Start button, and then point to Programs.

2 Point to the folder that contains Vision StoryBoard, and click the Vision StoryBoard icon. The Welcome dialog box appears. 

3 Choose one of the following: 

Quick Slide Show to create a quick slide show. 
    How?

Quick Document to create a quick output document.
    How?

New Project to open a new Visual Basic project. 

Existing Project to open an existing Visual Basic project.
    How?

Visual Basic 4.0 is started and the Vision StoryBoard main window appears.

{button ,AL(`start',0,`',`')}    Related Topics



Start Visual Basic with Vision StoryBoard

If you start Vision StoryBoard from the Start button, Visual Basic is started at the same time.

Warning!

Do not start a second session of Vision StoryBoard if one is already running. Running more than one session of Vision 
StoryBoard at a time may cause problems.

To start Visual Basic with Vision StoryBoard

1 Click the Start button, and then point to Programs.

2 Point to the folder that contains Vision StoryBoard, and click the Vision StoryBoard icon. The Welcome dialog box appears. 

3 Choose one of the following: 

Quick Slide Show to create a quick slide show. 
    How?

Quick Document to create a quick output document.
    How?

New Project to open a new Visual Basic project. 

Existing Project to open an existing Visual Basic project.
    How?

Visual Basic 4.0 is started and the Vision StoryBoard main window appears.

{button ,AL(`start',0,`',`')}    Related Topics



Open an Existing Project

1 Choose Existing Project. 

2 Navigate to the project that you want to open. 

3 Select it.

4 Choose the OK button. 



Open a New Visual Basic Project

From the Visual Basic File menu, choose New Project.

You will be prompted by Visual Basic and Vision StoryBoard to save any changes you have made to the current project.



Open an Existing Visual Basic Project

1 From the Visual Basic File menu, choose Open Project.

2 Navigate to the project you want to open, select it, and choose OK.

You will be prompted by Visual Basic and Vision StoryBoard to save any changes you have made to the current project.



Create a Quick Slide Show

1 Start Vision StoryBoard from the Start button when Visual Basic is not running. 

2 In the Welcome dialog box, click , or select Quick Slide Show and choose OK. The Open Project dialog box appears.
3 Navigate to the Visual Basic project that you want to create a slide show about, select it, and choose the OK button. After 
the project is opened, the New SlideShow dialog box appears.
4 Select the forms that you want to include in the slide show. 

How?

5 Select a slide size.

6 Select a callout size.

7 Choose the OK button.

The SlideShow Sorter window appears with the new slide show.

{button ,AL(`create new slide show',0,`',`')}    Related Topics



Create a Quick Document

1 Start Vision StoryBoard from the Start button when Visual Basic is not running. 

2 In the Welcome dialog box, click , or select Quick Document and choose OK. The Open Project dialog box appears.
3 Navigate to the Visual Basic project that you want to document, select it, and choose the OK button. After the project is 
opened, the Generate Document dialog box appears.
4 To save the output document with a different name or in a different directory, enter the file name and path in the File Name
text box or click the browse button to open the Browse dialog box.

5 Select a document type from the drop-down list. 

6 If the forms are in form groups, select a group. The forms in the group appear in the Forms list. To list forms that are not in a 
group, select the project (the highest level group). 

7 Select the forms that you want to include in the output document.

How?

8 Select the slides from the current slide show that you want to include in the output document. 

How?

9 Choose the OK button to generate the output file.

To view and print the output document, open it in a word processing program such as Microsoft Word. 

{button ,AL(`generating documents;printing documents',0,`',`')}    Related Topics



Quit Vision StoryBoard

When you quit Visual Basic, Vision StoryBoard is automatically closed. You can also quit Vision StoryBoard without quitting 
Visual Basic.

To quit Vision StoryBoard without quitting Visual Basic

1 From the Add-Ins menu on the Visual Basic 4.0 tool bar, select Add-In Manager.

2 In the Add-In Manager dialog box, clear Vision StoryBoard, and click OK. If you have not saved your Vision StoryBoard 
project, you are prompted to do so.

Note

If you remove Vision StoryBoard from the Add-In menu, Vision StoryBoard is no longer automatically started with Visual Basic 
4.0.

To quit Vision StoryBoard and Visual Basic
From the Visual Basic File menu, choose Exit. You are prompted to save your Visual Basic project. If you have not saved 

your Vision StoryBoard work, you are prompted to do so.

{button ,AL(`start',0,`',`')}    Related Topics



Select a Form

n To add a form, select the form in the Forms list and then click the arrow toward the Selected Forms list. 

n To add all the forms, click the double arrow toward the Selected Forms list.

n To remove a form, select the form in the Selected Forms list and then click the arrow away from the Selected Forms list.

n To remove all the forms, click the double arrow away from the Selected Forms list.



Select a Slide

n To add a slide, select the slide in the Slides list and then click the arrow toward the Selected Slides list. 

n To add all the slides, click the double arrow toward the Selected Slides list.

n To remove a slide, select the slide in the Selected Slides list and then click the arrow away from the Selected Slides list.

n To remove all the slides, click the double arrow away from the Selected Slides list.
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Overview of SlideShow 

In SlideShow, you can make annotated illustrations or slides of the forms in your Visual Basic project. You can arrange the slides
and play them as a slide show to demonstrate the form flow of your application. 

SlideShow has three views: Sorter, Designer, and Player. Each view lets you work on a different aspect of your slide show. 

More information.

What do you want to do?
Create a new slide show
Configure SlideShow
Open an existing slide show
Work with slides
Design slides
Play a slide show
Save a slide show
Print a slide show



SlideShow Views

SlideShow has three views. Each view lets you work on a different aspect of your slide show.

    SlideShow Sorter

In SlideShow Sorter, you can work with the slides in several ways:

n Add new slides

n Sort the slides

n Duplicate slides

n Delete slides

n Change a slide’s name or description

    SlideShow Designer

In SlideShow Designer, you can design slides. Slides can have these features:

n Callouts

n Background slides

n Jumps to other slides

n Pop-up lists of menu items

    SlideShow Player

In SlideShow Player, you can play the slide show. 



Switch to the SlideShow Sorter View

Click 
 at the bottom of the SlideShow Designer window.

When you go back to SlideShow Sorter, the slide is captured and held in memory until you save the slide show. When you close 
Vision StoryBoard, you are prompted to save.

{button ,AL(`Designer view',0,`',`')}    Related Topics



Switch to the SlideShow Designer View

Do one of the following in SlideShow Sorter:

n Select the slide that you want to work on, and click  at the bottom of the window.
n Double click the slide that you want to work on.

The slide appears in SlideShow Designer. If the slide is a new slide, the window is empty.

{button ,AL(`Sorter view',0,`',`')}    Related Topics



Open a Slide in SlideShow Designer

1 Open the slide show, if it is not already open. 

How?

2 Do one of the following:

n Select the slide, and click  at the bottom of the window.
n Double click the slide.

The slide appears in SlideShow Designer. If the slide is a new slide, the window is empty.

{button ,AL(`Sorter view',0,`',`')}    Related Topics



Overview of Creating a New Slide Show

You can create a new slide show of your current Visual Basic project at any time. Slides are created of the forms you select. 
Callouts are created for controls in the forms. Information from SpecMaker is entered in the callouts as the annotation text. 

The callouts are placed on the slide beginning with the upper left control and continuing down the left half of the form until space 
on the slide is filled. Then callouts for controls on the right half of the form are created beginning at the top and working down 
until the space is filled.

You can select the controls to annotate and the document categories to use as the annotation text by configuring SlideShow.

What do you want to do?
Enter annotation text
Create a new slide show
Configure SlideShow



Enter Default Annotation Text for a Slide Show

The default annotation text that appears in the callouts in a new slide show is entered in SpecMaker.

1 If the SpecMaker window is not open, open SpecMaker. 

How?

2 In your Visual Basic project, select the control that you want to enter annotation text for.

3 In SpecMaker, enter information about the control in the document category that is configured as the default annotation text 
for this control type.

{button ,AL(`annotate',0,`',`')}    Related Topics



Select the Slide Size

The slide size (small, medium, or large) determines the area used for the form and the callouts in a new slide show. 

If you select large, the slide fills the entire screen when the window fills the screen (the default). The form and the callouts are 
placed in the center of the screen. 

If you select medium or small, the slide still appears to fill the whole screen. However, the actual area used for the form and the 
callouts is smaller. The form is no longer centered in the screen. It is moved up and to the left so that it is centered in the smaller 
area.

The best slide size to choose depends on several factors:

n The resolution of your monitor. In most cases, at lower resolutions, small is the best choice. At higher resolutions, medium or 
large give good results. 

n The number of callouts you want to fit on the slide. The larger the slide, the more room is available for callouts. The callout 
size also affects the number of callouts. The smaller the callouts, the more fit on the slide. However, smaller callouts show less
text.

n Your available disk space. Larger slides require more disk space when saved.

Note

The size of the form on the slide does not affect the size of the slide. A form on a slide is the same size as the form is in your 
Visual Basic project. 



Select the Callout Size

The callout size determines how much of the annotation text appears in the callout. The callout size and the slide size together 
determine how many callouts fit on the slide.

The best callout size to choose (small, medium, or large) depends on several factors:

n The resolution of your monitor. In most cases, medium gives good results. 

n The number of callouts you want to fit on the slide. The smaller the callouts, the more fit on the slide. 

n The amount of text you want to fit in the callout. Larger callouts show more text.

n The slide size.



Create a New Slide Show

1 From the File menu, choose New SlideShow. The New SlideShow dialog box appears.

2 Select the forms that you want to include in the slide show. 

How?

3 Select a slide size.

4 Select a callout size.

5 Choose the OK button.

{button ,AL(`annotate',0,`',`')}    Related Topics



Create a New Slide Show from the Tools Menu

1 Do one of the following:

n Choose  from the Vision StoryBoard toolbar. 
n From the Tools menu, choose SlideShow. 

If no slide show is open, the Open SlideShow dialog box appears.

2 Choose New SlideShow. The New SlideShow dialog box appears.

3 Select the forms that you want to include in the slide show. 

How?

4 Select a slide size.

5 Select a callout size.

6 Choose the OK button.

{button ,AL(`annotate',0,`',`')}    Related Topics



Create a New Slide Show from the Open SlideShow Dialog Box

1 Choose New SlideShow. The New SlideShow dialog box appears.

2 Select the forms that you want to include in the slide show. 

How?

3 Select a slide size.

4 Select a callout size.

5 Choose the OK button.



Overview of Configuring SlideShow

Initially, SlideShow is configured to annotate all text boxes and command buttons with callouts and to use information in the 
document category Functional Description as the annotation text. Before you create a new slide show, you can configure 
SlideShow in several ways.

What do you want to do?
Select the control types to annotate by default
Override the default annotation setting for a specific control
Select the document categories to use as the annotation text for each control type



Annotate Control Types by Default

You can select the controls to annotate by default in a new slide show. Initially, the controls that are annotated by default are text 
boxes and command buttons.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select a control type.

4 In the SlideShow frame, select Annotate in Slide Show by Default.

5 When you are finished with the Configure dialog box, choose the OK button.

Note

You can override the default for an individual control with the Annotate in Slide Show option.

How?

{button ,AL(`annotate;create new slide show',0,`',`')}    Related Topics



Override the Annotation Default

You can determine if a specific control is annotated in a new slide show by overriding the Annotate in Slide Show by Default 
setting with the Annotate in Slide Show option in SpecMaker.

1 If the SpecMaker window is not open, open SpecMaker. 

How?

2 In your Visual Basic project, select the control.

3 In SpecMaker, do one of the following:

n Select Annotate in Slide Show, if you want the control to be annotated in a new slide show.

n Clear Annotate in Slide Show, if you do not want the control to be annotated in a new slide show.

{button ,AL(`annotate;create new slide show',0,`',`')}    Related Topics



Select Document Categories for the Annotation Text

You can select the document category to use as the default annotation text in a new slide show for each control type. Initially, the
document category Functional Description is used for all control types.

1 From the Tools menu, choose Configure.

2 Choose Control Display. 

3 In the Control Type list box, select a control type.

4 In the SlideShow frame, select a category in the Document Category for Default Annotate Text in Callouts list box.

5 When you are finished with the Configure dialog box, choose the OK button.

{button ,AL(`annotate',0,`',`')}    Related Topics



Start SlideShow

1 Do one of the following:

n Click  on the Vision StoryBoard toolbar.
n From the Tools menu, choose SlideShow.

The Open SlideShow dialog box appears.

2 Do one of the following:

n To create a New SlideShow, choose New SlideShow.

n To open an existing slide show, choose Existing SlideShow, navigate to the slide show that you want to open, and choose 
the OK button.

{button ,AL(`create new slide show',0,`',`')}    Related Topics



Open a Slide Show

1 From the File menu, choose Open SlideShow. The Open Existing SlideShow dialog box appears.

2 Navigate to the slide show that you want to open.

3 Choose the OK button. 



Open a Slide Show

1 From the File menu, choose Open SlideShow. The Open Existing SlideShow dialog box appears.

2 Navigate to the slide show that you want to open.

3 Choose the OK button. 



Open a Slide Show from the Tools Menu

1 Do one of the following:

n Choose  from the Vision StoryBoard toolbar. 
n From the Tools menu, choose SlideShow. 

If no slide show is open, the Open SlideShow dialog box appears.

2 Choose Existing SlideShow. The Open Existing SlideShow dialog box appears.

3 Navigate to the slide show that you want to open and select it.

4 Choose the OK button. 

Note

You can also create a new slide show from the Tools menu.

How?



Open a Slide Show

1 Choose Existing SlideShow. The Open Existing SlideShow dialog box appears.

2 Navigate to the slide show that you want to open and select it.

3 Choose the OK button. 



Working with Slides

In SlideShow Sorter, you can work with the slides in several ways.

What do you want to do?
Add new slides
Sort the slides
Duplicate slides
Delete slides
Change a slide’s name or description



Sort Slides

In SlideShow Sorter, drag the selected slide over the slide that you want to put the selected slide before. 

Note

Slides appear in SlideShow Player as they are ordered in SlideShow Sorter. 

{button ,AL(`work with slides',0,`',`')}    Related Topics



Add a New Slide 

1 Click  in the SlideShow Sorter toolbox. The New Slide dialog box appears.
2 Type a name for the slide in the Name text box.
3 If you want, type a description in the Description text box.
4 Choose the OK button. 

SlideShow Sorter appears with a new empty slide with the name you entered.

{button ,AL(`work with slides',0,`',`')}    Related Topics



Duplicate a Slide

1 In SlideShow Sorter, select the slide to duplicate. 

2 Click  in the SlideShow Sorter toolbox. The Duplicate Slide dialog box appears.
3 The name of the selected slide is displayed in the Current Slide box. If you want to copy a different slide, select the name 
from the drop-down list. 
4 Enter a name for the new slide. 
5 Enter a description for the new slide.
6 Choose the OK button. 

The new slide appears in the SlideShow Sorter window.

{button ,AL(`work with slides',0,`',`')}    Related Topics



Delete a Slide

Warning!

If you delete a slide, you cannot restore it.

To delete a slide

1 In SlideShow Sorter, select the slide to delete. 

2 Click  in the SlideShow Sorter toolbox.
3 Choose Yes in the confirmation message box.

Note

To select multiple slides to delete, hold down the SHIFT key on the keyboard and select the slides with the mouse.

{button ,AL(`work with slides',0,`',`')}    Related Topics



Change Slide Properties

You can change the name and description of a slide. 

1 In SlideShow Sorter, select the slide.

2 Click  in the SlideShow Sorter toolbox. The Change Slide Properties dialog box appears.
3 Change the name of the slide in the Name box.
4 Change the description of the slide in the Description box.
5 Choose the OK button.

{button ,AL(`work with slides',0,`',`')}    Related Topics



Designing Slides

In SlideShow Designer, you can change the look of a slide in several ways. 

What do you want to do?
Add a form to a slide
Add a callout to a slide
Add a text box to a slide
Work with text on a slide
Add a line to a slide
Add a background to a slide
Add a jump to a slide
Change the size of a slide 



Change the Size of a Slide

You can change the apparent size of a slide by making the SlideShow Designer window smaller. 

Only the part of the slide that appears in the SlideShow Designer window will appear in the slide in SlideShow Player. However, 
the part of the slide that does not show is not deleted. If you open the slide in SlideShow Designer and make the window bigger, 
the other part of the slide becomes visible again. 

Example

If you want a slide show that is smaller than your full screen, choose small as the slide size when you create the new slide show. 
Then reduce the SlideShow window to the size of the area used by the form and its callouts.



Overview of Forms on Slides

There is one form on each slide in a new slide show. If you add a slide to a slide show, you can also add a form to the new slide. 

The form on the slide is the same size as it is in your Visual Basic project. You cannot change the size of the form on the slide, 
but you can move the form. You can also delete a form if necessary.

A slide cannot have more than one active form. However, you can show another form on the slide by adding a background.

What do you want to do?
Add a form to a slide 
Move a form on a slide 
Delete a form on a slide 
Add a background to a slide



Add a Form to a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox. The Add Form dialog box appears.
3 Select a form by clicking the name in the Name drop-down list box. 
4 Choose the OK button. The form you selected appears in the SlideShow Designer window.
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Move a Form on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Move the cursor over the form’s title bar until the cursor changes to a four-pointed arrow.

3 Hold down the left mouse button and drag the form to the location you want.

{button ,AL(`forms on slides',0,`',`')}    Related Topics



Delete a Form on a Slide

When you delete a form on a slide, all of the callouts are also deleted. Items that are not attached to the form (the text boxes, 
hotspots, lines, and background) remain on the slide.

Warning!

If you delete a form on a slide, you cannot restore it.

To delete a form and all callouts on a slide

1 Open the slide in SlideShow Designer. 

How?

2 Press SHIFT+DEL on the keyboard.

{button ,AL(`forms on slides',0,`',`')}    Related Topics



Overview of Callouts on Slides

You can change or delete the callouts that appear on the slides in a new slide show. You can also add more callouts.

What do you want to do?
Add a callout to a slide
Add text to a callout 
Move a callout 
Change the size of a callout 
Delete a callout 



Add a Callout to a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox.
3 Place the cursor over the control that you want the callout to point to.
4 Hold down the left mouse button and drag the text box to the position you want in the slide. 

{button ,AL(`callouts',0,`',`')}    Related Topics



Add Text to a Callout on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Click inside the callout text box to move the focus there. 

3 Type directly into the box, or copy text from SpecMaker. 

How?

{button ,AL(`add callout;change callout size;text',0,`',`')}    Related Topics



Move a Callout on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Select the callout. When a callout is selected, handles appear on the text box and the line.

3 Move the mouse over the callout. When the cursor changes to a four-pointed arrow, hold down the left mouse button and drag
the callout.

The callout line is attached to the closest corner of the text box. If you move a text box from one side of a slide to the other, drag 
the callout line around the text box until it moves to a different corner.
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Change the Size of a Callout on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Select the callout. When a callout is selected, handles appear on the text box and the line.

3 Move the mouse over the callout. When the cursor changes to a double arrow over a handle, hold down the left mouse button 
and drag the handle.

{button ,AL(`callouts',0,`',`')}    Related Topics



Delete a Callout on a Slide

Warning!

If you delete a callout, you cannot restore it.

To delete a callout

1 Open the slide in SlideShow Designer. 

How?

2 Select the callout. When a callout is selected, handles appear on the text box and the line.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press the DELETE key on the keyboard.

{button ,AL(`callouts;select drawing objects',0,`',`')}    Related Topics



Overview of Text Boxes on Slides

You can add a text box anywhere on a slide as a label, title, or note. You can also add a text box and a line instead of a callout.

What do you want to do?
Add a text box to a slide
Add text to a text box
Change the size of a text box
Move a text box
Delete a text box



Add a Text Box to a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox. The screen cursor turns into a plus sign (+).
3 Hold down the left mouse button and drag the cursor to draw a box. When you release the mouse button the text box is 
created.

{button ,AL(`text boxes',0,`',`')}    Related Topics



Add Text to a Text Box

1 Open the slide in SlideShow Designer. 

How?

2 Click inside the text box to move the focus there. 

3 Type directly into the box, or copy text from SpecMaker. 

How?

{button ,AL(`add text box;change text box size;text',0,`',`')}    Related Topics



Change the Size of a Text Box

1 Open the slide in SlideShow Designer. 

How?

2 Select the text box so that the sizing handles show.

3 Move the cursor over the box with the mouse. When the cursor changes to a double arrow over a handle, hold down the left 
mouse button and drag the handle.

{button ,AL(`text boxes',0,`',`')}    Related Topics



Move a Text Box

1 Open the slide in SlideShow Designer. 

How?

2 Select the text box so that the sizing handles show.

3 Move the cursor over the box with the mouse. When the cursor changes to a four-pointed arrow, hold down the left mouse 
button and drag the box.
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Delete a Text Box

Warning!

If you delete a text box, you cannot restore it.

To delete a text box

1 Open the slide in SlideShow Designer. 

How?

2 Select the text box so that the sizing handles show.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press the DELETE key on the keyboard.
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Working with Text on Slides

You can copy text from SpecMaker or another Windows program to a slide. You can format the text on the slide.

What do you want to do?
Copy text from SpecMaker 
Format text 
Delete text 
Copy text 
Paste text 
Undo text edits



Copy Text from SpecMaker

You can add text to a callout or a text box by copying text from SpecMaker.

1 Open the slide in SlideShow Designer. 

How?

2 If SpecMaker is not open, open SpecMaker. 

How?

3 In your Visual Basic project, select the control or form that you want to copy text about. For menu items, open the Visual Basic
Menu Editor and select the menu item. 

4 Select the text that you want to copy in SpecMaker.

5 Press Ctrl+C on the keyboard.

6 Move the focus to the text box on the slide that you want to enter the text in.

7 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press CTRL+V on the keyboard.

Use the Up and Down arrows to scroll through the text in the text box. You may need to change the size of the text box to show 
all of the text.
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Format Text on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Move the focus to the callout or text box whose text format you want to change. 

3 Click  in the SlideShow Designer toolbox. The Font dialog box opens.
4 Choose a font, font style, size, and color, and select strikeout and underline, if desired. A sample of the selected font 
appears in the Sample frame.
5 Choose the OK button. 

The format is applied to all of the text in the selected text box or callout and to all of the text that you enter until you set the 
format again.

{button ,AL(`text',0,`',`')}    Related Topics



Delete Text on a Slide

You can delete text from a slide permanently. You can also delete text and then paste it in another callout or text box on a slide. 

1 Open the slide in SlideShow Designer. 

How?

2 Select the text that you want to delete.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press CTRL+X on the keyboard.

The text is deleted from the slide and copied onto the Clipboard. You can paste the text in another text box or callout from the 
Clipboard.

If you accidentally delete text, you can restore it by clicking .
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Copy Text on a Slide

You can copy text on a slide and then paste it in another callout or text box on a slide. 

1 Open the slide in SlideShow Designer. 

How?

2 Select the text that you want to copy.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press CTRL+C on the keyboard.

The text is copied to the Clipboard. You can paste the text in another text box or callout from the Clipboard.
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Paste Text on a Slide

You can paste text in a callout or text box on a slide from the Clipboard. The text can be placed on the Clipboard from another 
slide, SpecMaker, or other Windows programs.

1 Open the slide in SlideShow Designer. 

How?

2 Move the focus to the text box that you want to enter the text in.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press CTRL+V on the keyboard.

Use the Up and Down arrows to scroll through the text in the text box. You may need to change the size of the text box to show 
all of the text.

If you accidentally paste text, you can reverse the action by clicking .
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Undo Text Edits

If you accidentally cut or paste text in a callout or text box on a slide, you can reverse the action.
Click 

 in the SlideShow Designer toolbox.
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Overview of Lines on a Slide

You can draw a line anywhere on a slide. You can set the color and style of the line.

What do you want to do?
Draw a line
Move a line
Change the size of a line
Delete a line
Set a line style
Set a line color



Draw a Line

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox. The screen cursor turns into a plus sign (+).
3 Drag the cursor while holding down the left mouse button. When you release the button, the line is created. 
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Move a Line

1 Open the slide in SlideShow Designer. 

How?

2 Select the line so the handles on each end show.

3 Move the cursor over the line with the mouse. 

4 When the cursor changes to a four-pointed arrow over the line, hold down the left mouse button and drag the line to a new 
position.
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Change the Size of a Line

1 Open the slide in SlideShow Designer. 

How?

2 Select the line so the handles on each end show.

3 Move the cursor over the line with the mouse. 

4 When the cursor changes to crosshairs over a handle, hold down the left mouse button and drag the handle.
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Delete a Line

1 Open the slide in SlideShow Designer. 

How?

2 Select the line so the handles on each end show.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press the DELETE key on the keyboard.
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Set a Line Style

1 Open the slide in SlideShow Designer. 

How?

2 Select the line so the handles on each end show.

3 Click  in the SlideShow Designer toolbox. A box of line styles appears.
4 Choose the line style by clicking it with the mouse. If you decide not to change the current style, close the dialog box by 
clicking outside of it.

The style is applied to the selected line and all of the lines that you create until you set the style again.
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Set a Line Color

1 Open the slide in SlideShow Designer. 

How?

2 Select the line so the handles on each end show.

3 Click  in the SlideShow Designer toolbox. A box of line colors appears.
4 Choose the line color that you want by clicking it with the mouse. If you decide not to change the current color, close the 
dialog box by clicking outside of it. 

The color is applied to the selected line and all of the lines that you create until you set the color again.
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Select Drawing Objects

You can select multiple lines, text boxes, and callouts.

1 Click  in the SlideShow Designer toolbox.
2 Hold down the left mouse button and drag the cursor to create a rectangle around the objects that you want to select. 

When you release the mouse buttons, all objects within the rectangle are selected.

Note

Make sure you enclose the entire object in the selection. For example, when you select a callout, enclose the complete callout 
text box and line.



Delete a Drawing Object

You can delete lines, text boxes, callouts, and hotspots with the Delete tool.

Warning!

If you delete a drawing object, you cannot restore it.

To delete a drawing object

1 Open the slide in SlideShow Designer. 

How?

2 Select the drawing object. When an object is selected, handles appear on the object.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press the DELETE key on the keyboard.



Overview of Slide Backgrounds

Any slide can be used as a background for another slide. The background is a screen shot of the form that appears in the 
original slide. The text boxes and lines from the slide are not reproduced in the background. 

You can add only one background to a slide. However, you can create a background with more than one form by creating 
several slides each as a background for the next.

You can crop the background form if you want only part of it to appear on the slide.

What do you want to do?
Add a slide background
Crop a background 
Move a background 
Replace a background 



Add a Slide Background

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox. The Add Background dialog box appears.
3 Select a slide by clicking the name in the Name list box.
4 Choose the OK button. The SlideShow Designer window appears with the slide you selected as the background.
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Move a Background on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Hold down the SHIFT key on the keyboard and select the background with the left mouse button. When the background is 
selected a black border appears around it.

3 Drag the background with the mouse.

4 Release the mouse button.
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Crop a Background on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox. 

A black border appears around the background. When the mouse moves over the background, the cursor turns to a four-
pointed arrow.

3 Position the cursor at one corner of the area of the background that you want to keep. 

4 Hold down the left mouse button and drag the mouse to create a rectangle containing the part of the background that you 
want.

5 Release the mouse button. The area outside of the rectangle is cropped.
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Replace a Background on a Slide

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox. A message about the existing background appears.
3 In the message box, choose the OK button. The Add Background dialog box appears.
4 Select a slide in the Name list box. 
5 Choose the OK button.
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Overview of Jumps

You can create a jump from one slide to another slide. You can make the jump from a hotspot on a slide or from a menu item, as 
long as the menu item does not have any submenus.

In SlideShow Player, the cursor becomes a pointing hand as it moves over the hotspot. Menu items that are jumps are green. If 
you click on the hotspot or the menu item with a jump, the slide to which the jump is connected appears.

What do you want to do?
Create a jump from a hotspot
Change a jump from a hotspot
Delete a jump from a hotspot
Create a jump from a menu
Change a jump from a menu
Delete a jump from a menu



Create a Jump from a Hotspot

1 Open the slide in SlideShow Designer. 

How?

2 Click  in the SlideShow Designer toolbox.
3 Hold down the left mouse button and draw a rectangle where you want the hotspot to appear. When you release the 
mouse button, the Create Jump dialog box appears.
4 Click the arrow at the end of the Name drop-down list box to display the slide names; then select a slide. 
5 Choose the OK button. The hotspot appears as a dotted line box.

{button ,AL(`jump',0,`',`')}    Related Topics



Change a Jump from a Hotspot

You can change a jump so that it is connected to a different slide.

1 Open the slide in SlideShow Designer. 

How?

2 Select the hotspot. When the hotspot is selected, the dotted line around it changes color.

3 Click  in the SlideShow Designer toolbox. The Create Jump dialog box appears.
4 Click the arrow at the end of the Name drop-down list box to display the slide names; then select a slide. 
5 Choose the OK button.

{button ,AL(`jump',0,`',`')}    Related Topics



Delete a Jump from a Hotspot

1 Open the slide in SlideShow Designer. 

How?

2 Select the hotspot. When the hotspot is selected, the dotted line around it changes color.

3 Do one of the following:

n Click  in the SlideShow Designer toolbox.
n Press the DELETE key on the keyboard.

The hotspot and the jump are deleted.

{button ,AL(`jump',0,`',`')}    Related Topics



Create a Jump from a Menu

You can create a jump to another slide from a menu item as long as the menu item does not have any submenus.

1 Open the slide in SlideShow Designer. 

How?

2 Click the menu name to display the menu items; then click a menu item that does not have any submenus. The Create Jump 
dialog box appears.

3 Click the arrow at the end of the Name drop-down list box to display the slide names; then select a slide. 

4 Choose the OK button.
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Change a Jump from a Menu

1 Open the slide in SlideShow Designer. 

How?

2 Click the menu item with the jump. Menu items with jumps are green. When you click the menu item, the Create Jump dialog 
box appears.

3 Click the arrow at the end of the Name drop-down list box to display the slide names; then select a slide. 

4 Choose the OK button.

{button ,AL(`jump',0,`',`')}    Related Topics



Delete a Jump from a Menu

1 Open the slide in SlideShow Designer. 

How?

2 Click the menu item with the jump. Menu items with jumps are green. When you click the menu item, the Create Jump dialog 
box appears.

3 Clear the Name list box. 

4 Choose the OK button.

{button ,AL(`jump',0,`',`')}    Related Topics



Play a Slide Show

1 Open the slide show you want to play. 

How?

2 If you are in SlideShow Sorter, select the slide that you want to start the slide show with. In SlideShow Designer, the slide 
show starts with the current slide.

3 Click  at the bottom of the SlideShow window. The SlideShow Player window appears.
4 Play the slide show. 

n Click the Previous button to display the previously shown slide

n Click the Next button to display the next slide in the slide show

n If a slide contains a hotspot, click the hotspot to display the connected slide. The cursor changes to a pointing hand when it 
moves over a hotspot.

n Click the menu names to display the menu items. 

n If the slide contains a jump from a menu item, click the menu item to display the connected slide. Menu items that are 
jumps appear in green.

5 Choose the Exit button to close SlideShow Player.



Save a Slide Show

From the File menu, choose Save SlideShow.

If the slide show has never been saved, the Save SlideShow dialog box appears. Enter a file name and select the drive and 
directory for the file. Then choose the OK button.

{button ,AL(`saving slide shows',0,`',`')}    Related Topics



Save a Copy of a Slide Show

You can save a copy of the current slide show under a new name.

1 From the File menu, choose Save SlideShow As. The Save SlideShow As dialog box appears.

2 Enter the file name and select the drive and directory for the file.

3 Choose the OK button.

{button ,AL(`saving slide shows',0,`',`')}    Related Topics



Print Slide Shows

You can print the slides in the current slide show to an output document as bitmaps.

1 Open the slide show you want to print. 

How?

2 Do one of the following:

n Click  on the Vision StoryBoard toolbar.
n From the File menu, choose Generate  Document.

The Generate Document dialog box appears. 

3 To save the output document with a different name or directory, enter the file name and path in the File Name text box or click 
the browse button to open the Browse dialog box.

4 Select a document type from the drop-down list. 

5 Select the slides from the current slide show that you want to include in the output document. 

How?

6 If you want to include information from SpecMaker in the output document, do the following:

n If the forms are in form groups, select a group. The forms in the group appear in the Forms list. To list forms that are not in a
group, select the project (the highest level group). 

n Select the forms that you want to include in the output document. 
 How?

7 Choose the OK button to generate the output document.

{button ,AL(`generating documents',0,`',`')}    Related Topics
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Overview of Generate Online Help

Using StoryBoard’s Generate Online Help tool, you can generate an online help file for your users that contains Help Topics for 
the forms, controls, and menu items in your Visual Basic project. The help file is compiled from information you entered in 
SpecMaker.

When you are documenting your Visual Basic project in SpecMaker, you can assign a Help Title for each form, control, and 
menu item, and enter Help Text in an associated Online Help Document Category. For the Visual Basic objects that permit 
context-sensitive help, you can assign a Help Context ID value. You can also designate which document category is used as 
Help Text and specify which controls will have help associated with them in the Configure Online Help Dialog Box. 

At any point during the documentation of your project, you can generate online help. StoryBoard compiles the online help data 
for your project and generates a logical help system, including context-sensitive help, based on the form groups hierarchy you 
specified. The files for the online help system are located in the project directory by default.

After you have generated online help, you can use it directly, or open it in the help authoring tool RoboHELP.

What do you want to do?
Create Online Help Text
Configure Online Help
Generate Online Help
View Online Help
Open an Online Help Project in RoboHELP



Creating Online Help Text

For each form, control and menu item in your project, you can create Help Text which will be used when you generate online 
help. 

1 Give focus to the form or control in your Visual Basic project for which you want Help Text. (If you are documenting a menu 
item, open the Visual Basic Menu Editor from the Visual Basic Tools menu and select the menu item.)

2 Open SpecMaker.

n Click  on the Vision StoryBoard Toolbar.
n From the Tools menu, choose SpecMaker.

3 In the Document Categories frame of the SpecMaker Window, scroll to the document category associated with Online Help.

4 In the Online Help document category, enter Help Text for the Visual Basic object which has the focus.

5 Choose  on the Vision StoryBoard Toolbar to save this and any other outstanding changes to your project. 

Note

End-user Documentation Notes is the default document category associated with Help Text.

{button ,AL(`configuring help;online help doc category',0,`',`')}    Related Topics



Generating Online Help

You can generate an online help file based on the Help Context IDs, Help Titles and Help Text you entered in SpecMaker for your
forms, controls, and menu items. 

1 Do one of the following:

n Click  on the Vision StoryBoard toolbar.
n From the File menu, choose Generate  Online Help.

The default online help file name and path appear in the Help File text box of the Generate Online Help Dialog Box.

2 To save the online help file with a different name or in a different directory, enter an acceptable online help file name and path 
in the Help File text box or click the browse button to select the file name and path from the Browse dialog box. Please review 
information about the files StoryBoard generates for online help before assigning a file name for your online help file.

3 Check or uncheck the “Exclude Controls without Help Text” checkbox.

4 Choose the OK button to generate online help.

5 The Compiling Help status dialog box appears, indicating that online help is compiling. During the compile, any form that is not
open in the current session will open briefly in the background for bitmap capture.

6 When the online help is compiled, the Generating Help dialog box appears, listing the files that have been generated.

Once the online help files have been generated, you can do one of the following:

n Click the OK button to exit this dialog box.

n Click the View button to launch online help.

n Click the Launch RoboHELP button to open the online help project in RoboHELP.

Tip

If you want to generate two different online help files, such as one for your developers and one for your end users, designate 
one document category for developer’s online help and another document category for end user help in the Configure Control 
Display dialog box. Then generate online help twice, saving the online help file with a different name and assigning one of the 
online help document categories to it each time.

Warning

If you want to generate more than one version of online help for a project, make sure that the first 6 characters of the .hlp file 
name for each generated online help are unique. Because the .rtf and .hh file names for the online help project are derived 
from the first 6 characters of the .hlp file name, and the last 2 characters are truncated, file names such as “samples1.hlp” and
“samples2.hlp” will generate the .rtf and .hh files with the same file names (sample_H.rtf and sample_H.HH), and overwrite the
previous .rtf and .hh files. 

{button ,AL(`generating help;help files;viewing help;opening help',0,`',`')}    Related Topics



Overview of Configuring Online Help

Before you generate Online Help for your project, you can configure the online help file to specify what it contains after it is 
generated. You can:

n Associate a document category from SpecMaker to use as the Help Text for the project. Only one document category can be 
used for Help Text each time you generate Online Help. By default, StoryBoard uses the End-user Documentation Notes 
document category as the Help Text, but you can associate a different category as needed.

n Select the control types for your project that you want to appear in Online Help.

n Describe the form groups in the generated online help file. This configuration is made in the Configure Form Groups dialog 
box.

What do you want to do?
Associate the Online Help Document Category
Select the Controls to Appear in Online Help
Describe a Form Group



Overview of Creating Online Help

The online help file and context-sensitive help for your project are based on information that you specify in SpecMaker and the 
configurations you select in the Configure Online Help dialog box. In order to create online help, you need to:

n Assign a Help Context ID for each form, control, and menu item in your project.

n Assign a Help Title for each form, control, and menu item.

n Create Help Text for your project in SpecMaker.

n Configure online help, which includes:

n Associating an online help document category from SpecMaker to use as the Help Text for the project. Only one document 
category can be used for Help Text each time you generate Online Help. By default, StoryBoard uses the End-user 
Documentation Notes document category as the Help Text.

n Selecting the controls you want to appear in Online Help.

What do you want to do?
Assign an Online Help Title
Assign an Online Help Context ID
Create Online Help Text
Configure Online Help



Associate an Online Help Document Category

Before you generate Online Help, you can select the document category to use as Help Text. By default, the End-user 
Documentation Notes document category is used for this purpose.

1 From the Tools menu, choose Configure  Online Help.
2 In the Document Category frame, select a Document Category from the drop-down list box to use as Help Text.
3 When you are finished with the Configure Online Help dialog box, choose the OK button.

{button ,AL(`configuring help',0,`',`')}    Related Topics



Assign an Online Help Context ID

Before you generate Online Help, you can assign a Help Context ID for each form, control and menu item in your Visual Basic 
project. 

1 Give focus to a form or control in your Visual Basic project. (If you are documenting a menu item, open the Visual Basic Menu 
Editor from the Visual Basic Tools menu and select the menu item.)

2 Open SpecMaker in one of the following ways:

n Click  on the Vision StoryBoard Toolbar.
n From the Tools menu, choose SpecMaker.

3 In the Help Context ID text box of the Online Help Properties frame, enter a Help Context ID value for the selected object. This
value is also assigned to the HelpContextID property for that object in your Visual Basic project. 

4 Click on the object before changing focus in order to register the value in Visual Basic and display the value in SpecMaker.

5 Choose  on the Vision StoryBoard Toolbar to save this and any other outstanding changes to your project. 

{button ,AL(`configuring help',0,`',`')}    Related Topics



Change an Online Help Context ID

1 Give focus to a form or control in your Visual Basic project. (If you are documenting a menu item, open the Visual Basic Menu 
Editor from the Visual Basic Tools menu and select the menu item.)

2 Open SpecMaker in one of the following ways:

n Click  on the Vision StoryBoard Toolbar.
n From the Tools menu, choose SpecMaker.

3 In the Help Context ID text box of the Online Help Properties frame, enter a new Help Context ID value for the selected object.
This value is also assigned to the HelpContextID property for that object in your Visual Basic project.

4 Click on the object before changing focus in order to register the value in Visual Basic and display the value in SpecMaker.

5 Choose  on the Vision StoryBoard Toolbar to save this and any other outstanding changes to your project. 

{button ,AL(`configuring help',0,`',`')}    Related Topics



Assign an Online Help Title

Before you generate Online Help, you can assign a Help Title to each form and control in your Visual Basic project. 

1 Give focus to a form or control in your Visual Basic project. (If you are documenting a menu item, open the Visual Basic Menu 
Editor from the Visual Basic Tools menu and select the menu item.)

2 Open SpecMaker in one of the following ways:

n Click  on the Vision StoryBoard Toolbar.
n From the Tools menu, choose SpecMaker.

3 In the Help Title text box of the Online Help Properties frame, enter a Help Title for the selected object.

4 Choose  on the Vision StoryBoard Toolbar to save this and any other outstanding changes to your project. 

{button ,AL(`configuring help',0,`',`')}    Related Topics



Select the Controls to Appear in Online Help

Before you generate Online Help, you can select which controls to generate Help Text for in your Visual Basic project. 

1 From the Tools menu, choose Configure  Online Help.
2 In the Select/Deselect Help for Control frame, type yes in the Associate Help column beside the controls you want to 
appear in online help for your project.
3 Choose  on the Vision StoryBoard Toolbar to save this and any other outstanding changes to your project. 

Note

The control types which are available for online help are those that you have designated in the Configure Control Display 
dialog box. If you have not specified which control types to use, StoryBoard associates a default group of control types to be 
generated. If you do not see the control type in the Select/Deselect Help for Control frame that you want to appear in online 
help, reconfigure your control display to include that control type.

{button ,JI(`VISTORY.HLP',`Configure_Control_Display_Dialog_Box')}    How?
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Viewing Online Help

You can view the generated Online Help file for your project in the following ways:

1 Choose View Generated Online Help from the File Menu.

2 Navigate to the online help file you want to view.

3 Select it.

4 Choose the OK button.

OR

Double-click on the online help file in your project directory that you want to view.

OR

Click the View button from the Generating Help dialog box.

{button ,JI(`VISTORY.HLP',`Generating_Help_Dialog_Box')}    How? 
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Opening an Online Help Project in RoboHELP

You can open the generated online help .rtf file from StoryBoard in the following ways:

n Double-click the Launch RoboHELP command from the StoryBoard Files Menu.

n Click the Launch RoboHELP button from the Generating Help dialog box.

Note

When you save the .rtf in RoboHELP for the first time, you are prompted to associate an online help project file. You can 
associate either the online help project file which StoryBoard has provided, or associate a new or existing one. The map file 
(.hh)  generated by StoryBoard will automatically be associated with the help project at this time.

Note

The Launch RoboHELP command and Launch RoboHELP button do not display in StoryBoard unless RoboHELP is installed 
on your computer.




